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RESUMEN 

El ciruelo europeo (Prunus domestica L.) es una de las especies más relevantes a nivel económico dentro de los 

frutales de Carozo, siendo la variedad ‘D´Agen’ la más cultivada en nuestro país. El mejoramiento clásico de los 

frutales de carozo se realiza mediante cruzamientos entre parentales seleccionados y la evaluación y selección de la 

progenie resultante. Si bien este enfoque ha permitido obtener variedades elite en casi todas las especies del género 

Prunus, presenta limitaciones entre las cuales se encuentran los extensos ciclos reproductivos y largos periodos 

juveniles, siendo de entre 5-6 años en ciruelo. A esto se suma el tiempo necesario para la expresión completa del 

potencial genético y la evaluación de caracteres en distintos ambientes, totalizando unos 12-15 años para obtener 

una nueva variedad. El desarrollo de herramientas biotecnológicas, como la transformación genética, podría permitir 

la obtención de variedades mejoradas de forma discreta en un plazo relativamente corto. Sin embargo, a pesar de 

los esfuerzos por establecer protocolos eficientes de mejoramiento genético aplicables, en ciruelo europeo solo se 

han transformados unas pocas variedades y en la mayoría de los casos las eficiencias de transformación son bajas. 

El objetivo general de este trabajo fue desarrollar herramientas biotecnológicas para la mejora de ciruelo europeo. 

Para lo cual se construyó el vector pMDC32-ptFT1 el cual permitirá, en un futuro, su utilización para la 

transformación genética de frutales como ciruelo y duraznero, con el fin de acortar sus ciclos reproductivos mediante 

la expresión del gen ptFT1. Se definió también 5 mg/l como la concentración de Higromicina a utilizar en la 

selección de transformantes en futuros ensayos de transformación de cotiledones ‘D´Agen’ Se logró la 

transformación de diferentes cepas de A. tumefaciens con el vector pCAMBIA2301, sentando bases para futuros 

ensayos que permitan determinar y comparar su capacidad de transformación mediante la expresión de GUS en 

distintos tejidos. También se estableció la sensibilidad de las cepas a los antibióticos Cefotaxima y Timetina, siendo 

100 mg/l y 75 mg/l respectivamente, las concentraciones que inhiben el crecimiento de las mismas. Se logró la 

transformación transiente de hojas y cotiledones de 'D'Agen'. En cotiledones se estudió el efecto del estado 

fisiológico de la bacteria, la sonicación y la aplicación de vacío, sobre la expresión transiente del gen GUS. Y si 

bien no se obtuvo un modelo estadísticamente significativo, se identificaron factores que afectan la expresión 

transiente de GUS. Este trabajo representa el primer reporte sobre la transformación transiente de hojas y cotiledones 

de la variedad ‘D´Agen’. 
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1. INTRODUCCIÓN 

El género Prunus (familia Rosaceae) incluye varias especies de cultivos frutales de gran importancia económica, 

comúnmente llamados frutales de carozo. Estas especies son ampliamente cultivadas debido a las características 

organolépticas y el valor nutricional de sus frutas (Potter, 2012). Dentro de las más importantes de este grupo se 

encuentran Prunus pérsica (duraznero), Prunus cerasus (cerezos), Prunus domestica (ciruelo europeo), Prunus 

salicina (ciruelo japonés), Prunus armeniaca (damasco), entre otros (Kumar et al., 2022). 

En términos de importancia económica, las ciruelas ocupan el segundo lugar después del durazno y la nectarina 

(variedad de durazno de piel lisa) en la producción mundial de fruta de carozo, alcanzando alrededor de 12.600.000 

toneladas, con un aumento del 20 % en la última década según datos de la FAO a partir de 2019 (Sottile et al., 

2022). 

 Prunus domestica L., conocida comúnmente como ciruela europea, es una especie alohexaploide (2n = 6x = 48) 

cuya principal variedad comercial a nivel mundial es la D'Agen, destinada principalmente a la producción de ciruela 

pasa o deshidratada debido a su elevado contenido de azúcares y excelente sabor (Somogyi, 2005). 

Argentina se posiciona como el cuarto productor mundial de ciruelas deshidratadas, detrás de Estados Unidos, 

Chile y Francia. La provincia de Mendoza se destaca como principal productora, con un 89% de la producción 

destinada a la exportación a países como Rusia, Alemania, Brasil y Japón. La variedad D'Agen y su clon 707 abarcan 

el 98% de la superficie implantada, lo que convierte a este rubro en un pilar de la economía regional (IDR, 2015). 

Los objetivos actuales de mejora de este tipo de frutales se enfocan en la búsqueda de resistencia o tolerancia a 

estreses abióticos y bióticos, mejorar la calidad y aspecto de la fruta y reducir los costos de producción. Además, se 

busca ampliar el tiempo de disponibilidad de la fruta en el mercado y la adaptación al cambio climático (Sottile et 

al., 2022). 

El mejoramiento clásico de los frutales de carozo se realiza mediante cruzamientos entre parentales 

seleccionados y la evaluación y selección de la progenie resultante. Si bien este enfoque ha permitido obtener 

variedades elite en casi todas las especies del género Prunus, presenta limitaciones entre las cuales se encuentran 

los extensos ciclos reproductivos y largos periodos juveniles (3-4 años en duraznero y 5-6 en ciruelo) (Abbott et 

al., 2008; Milošević & Milošević, 2018). A esto se suma el tiempo necesario para la expresión completa del 

potencial genético y la evaluación de caracteres en distintos ambientes, totalizando unos 12-15 años para obtener 

una nueva variedad (Figura 1).  
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Debido a estas limitaciones, los programas de mejoramiento de frutales requieren de la utilización de tecnologías 

que aumenten la eficiencia del proceso. En este sentido, el empleo de herramientas biotecnológicas, como la 

transformación genética, permiten sortear dichas limitaciones al introducir genes entre especies emparentadas o no, 

confiriendo una nueva característica sin modificar ningún otro carácter al individuo. De esta manera, se evitan los 

sucesivos cruzamientos necesarios en el enfoque tradicional, acelerando así el proceso. 

 La transgénesis en frutales también se emplea como etapa intermedia para obtener líneas mejoradas. Un ejemplo 

es el sistema “Fastrack Breeding”, que introduce el gen Flowering Locus T (FT) para acelerar la floración. En 

ciruelos transformados, la sobreexpresión de FT de álamo (Populus trichocarpa) demostró alteraciones en la 

arquitectura, el requerimiento de dormancia y floración continua. Esto permite producir frutos en pocos meses, 

 

 

Figura 1. Esquema de un programa de mejora clásica de frutales basado en la 

realización de cruzamientos y selección. Fuente: Adaptada de Martínez-Gómez, 

2017. 
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reduciendo el ciclo de 3-7 años a menos de 1 año (Petri et al., 2018). El mejoramiento con este sistema consta de 4 

pasos principales (Figura 2). 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Si bien la transgénesis confiere ventajas, es un proceso complejo con múltiples etapas: aislamiento del gen, 

construcción del casette de expresión, transferencia al genoma vegetal y sistemas de selección y regeneración de 

las células transformadas. En este último radica la mayor limitación para el género Prunus, ya que son recalcitrantes 

al cultivo in vitro, es decir que tienen poca tendencia a regenerar brotes a partir de células o tejidos cultivados in 

vitro, al igual que la mayoría de los frutales leñosos. Esto se refleja en la escasez de protocolos eficientes reportados 

a nivel mundial para estas especies (Petri et al., 2018; Ricci et al., 2020). 

 
 

 
 

 
 

 

 

Figura 2.  Ejemplo de la tecnología FasTrack. El esquema muestra un procedimiento para 

introducir un rasgo resistente a una enfermedad a un clon de elite o cultivar comercial. Paso 

1: Se cruza una ciruela FT de floración temprana con un genotipo resistente (R). Entre la 

progenie de las ciruelas FT, se seleccionan los individuos resistentes utilizando la selección 

asistida por marcadores (MAS). Paso 2: Se cruzan los individuos resistentes y con FT y el tipo 

de ciruela deseado. Paso 3: Se realizan dos retrocruzas con el genotipo original utilizando 

MAS para seleccionar los rasgos deseables. Paso 4: Se selecciona la progenie resistente (R) 

con los rasgos originales deseados (círculo rojo). Los árboles resultantes no son transgénicos y 

pueden ser llevados a campo para la evaluación. Fuente: Petri et al., 2018 



15 

 

 

 

1.1 Transformación genética 

1.1.1 Clonación 

Para introducir un transgén en la planta, primero debe ser clonado, es decir insertado, en un vector o plásmido 

que funcionará como vehículo de transporte. En el vector se clona el casette de expresión, que contiene la secuencia 

codificante del gen de interés y secuencias reguladoras independientes que dirigirán la expresión del transgén en la 

célula vegetal (Figura 3). 

 

 

 

 

 

 

 

 

 

 

 

 

Tradicionalmente, este procedimiento de clonación se basa en la digestión mediante enzimas de restricción, que 

reconocen y cortan secuencias específicas para generar un fragmento que luego se inserta en un vector mediante un 

proceso de ligación catalizado por la enzima ADN ligasa, que une los extremos del inserto y del vector. Desde hace 

un tiempo existen sistemas de clonación que permiten ensamblar múltiples fragmentos de ADN de forma precisa, 

eficiente y con orientación definida, superando las limitaciones de la clonación convencional. Un ejemplo es el 

sistema Gateway, basado en la recombinación específica del fago lambda.  

 
 

 
 

 
 

 

 

 

 

 

 

Figura 3. Esquema de un vector de expresión en plantas.  

 Se muestran los diferentes elementos que componen el vector: el cassette de 

expresión, compuesto por el promotor, la secuencia codificante del gen y un 

terminador; Ori, origen de replicación en la bacteria; ATBR, gen de resistencia al 

antibiótico de selección; y marcador de selección. 

 



16 

 

La tecnología Gateway permite clonar, combinar y transferir fragmentos de ADN entre distintas plataformas de 

expresión, manteniendo la orientación y el marco de lectura. Consta de tres pasos: 1) Amplificación del gen por 

PCR; 2) Clonación del producto en un vector de entrada mediante recombinación, sin digestión/ligación (reacción 

BP); 3) Subclonación del gen desde el vector de entrada a uno de destino (reacción LR) (Traore & Zhao, 2011) 

(Figura 4). 

 

 

 

 

 

 

 

 

 

En la reacción BP, la mezcla de enzimas BP Clonasa II cataliza la transferencia de un fragmento de ADN 

flanqueado por dos sitios attB a un vector donante que contiene dos sitios attP. Luego de la recombinación entre 

estos sitios, el fragmento de ADN se inserta en el vector donante, creando un clon de entrada (pENTR) flanqueado 

por dos sitios attL. En la reacción LR, la mezcla de enzimas LR Clonasa II cataliza la transferencia del fragmento 

de ADN desde el clon de entrada (pENTR) a un vector de destino que contiene dos sitios attR. Luego de la 

recombinación entre los sitios attL y attR, el fragmento de ADN se inserta en el vector de destino (pDEST) (Karimi 

et al., 2007). El producto de esta reacción LR es el clon de expresión, que lleva el gen de interés, y el vector donante, 

que en este punto se considera un subproducto de la reacción. De esta reacción se toma una alícuota para transformar 

células de Escherichia coli competentes. Para seleccionar las células que solo fueron transformadas con el clon de 

expresión, este sistema utiliza dos esquemas: primero, el clon de entrada y el vector de destino contienen diferentes 

genes de resistencia a los antibióticos (Kanamicina y Ampicilina en el ejemplo que se muestra en la Figura 4); en 

segundo lugar, el vector de destino contiene un marcador contra seleccionable, el gen ccdB, que destruye las células 

al inducir la rotura del ADN de doble cadena mediada por la enzima girasa. Las cepas de E. coli deben ser sensibles 

al efecto tóxico de ccdB, como lo es DH5α (Traore & Zhao, 2011). Mientras que las cepas que mantienen los 

vectores destino que contienen el gen ccdB deben ser resistentes al mismo, como por ejemplo la cepa de E. coli 

Figura 4.  Las reacciones de Gateway. El esquema muestra los cuatro tipos de plásmidos y mezclas de 

enzimas involucradas en las reacciones de clonación de Gateway. Las flechas rojas representan el fragmento 

de interés. Los términos clon de entrada, vector de destino, clon de expresión y vector donante son utilizados 

para distinguir los plásmidos de entrada y salida en las reacciones Gateway. Fuente: Katzen, 2007. 
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DB3.1. Con este esquema, al final del proceso, sólo quedan las células transformadas con el clon de expresión de 

interés.  

1.1.2 Métodos de transformación 

Para introducir el transgén en las células vegetales se han empleado diversas técnicas que se pueden clasificar 

en directas e indirectas, de acuerdo con el mecanismo utilizado para la transferencia del material genético hacia la 

célula vegetal (Díaz Granados & Chaparro-Giraldo, 2012). 

Técnicas directas 

En las técnicas directas, el ADN ingresa al interior de la célula mediante la inducción de la permeabilidad de la 

membrana celular. Dentro de estas técnicas se encuentra la electroporación, que consiste en la aplicación de un 

campo eléctrico que induce un cambio en el potencial de membrana y la generación de microporos, lo que la hace 

permeable a moléculas de gran tamaño. Otra estrategia emplea polietilenglicol (PEG), un polímero que tiene la 

capacidad de aumentar la permeabilidad de la membrana celular. Estas técnicas normalmente se utilizan en la 

transformación de protoplastos (Nkaa & Okpe, 2021). 

La biobalística es una de las técnicas directas más utilizadas. Ésta se basa en la utilización de microproyectiles 

(tungsteno u oro) recubiertos del ADN que se desea transferir, los cuales son disparados sobre el tejido vegetal a 

alta velocidad atravesando la pared, la membrana celular y el núcleo. Cuando la partícula ha ingresado al núcleo de 

la célula, el ADN se libera y por recombinación se inserta en el genoma. Este método no requiere de ningún vector 

para la transferencia de genes y no depende del tipo de célula, especie y genotipo, pero presenta como desventaja 

ser muy agresivo con el tejido. Además, es frecuente la inserción de varias copias del ADN que pueden ir en tándem, 

lo que puede inducir silenciamiento génico del transgen (Chakraborty et al., 2020).  

Técnicas indirectas 

Los métodos indirectos utilizan intermediarios biológicos para transferir el ADN deseado a las células vegetales. 

El método más utilizado es Agrobacterium, una bacteria Gram negativa patógena de plantas que tiene la capacidad 

natural de modificar genéticamente al huésped mediante la transferencia de un fragmento de su ADN al genoma de 

la planta infectada. El fragmento de ADN que se transfiere se conoce como región T-DNA, el cual contiene genes 

que promueven la producción de aminoácidos especializados llamados opinas, utilizadas como fuente de alimento 

para la bacteria, así como genes que codifican enzimas relacionadas con la ruta de síntesis de reguladores de 

crecimiento, como auxinas y citocininas, que mantienen a las células vegetales en activa división.  

La región T-DNA se localiza en el plásmido Ti (inductor de tumores) de la bacteria. El plásmido Ti contiene 

varias regiones: un origen de replicación, la región Vir que contiene los genes de virulencia (genes vir) necesarios 

para transferir el T-DNA a la planta y la región T-DNA en sí. Esta última región está flanqueada por unos bordes 
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de 25 nucleótidos que son las secuencias reconocidas por la maquinaria de transferencia, denominados borde 

izquierdo (LB) y derecho (RB).   

En cuanto a la capacidad de transferir ADN, las dos especies de Agrobacterium que se utilizan para la 

transformación vegetal son Agrobacterium tumefaciens y Agrobacterium rizogenes. La diferencia entre ellas radica 

en los genes que transfieren, lo que resulta en diferentes síntomas al infectar la planta. En el caso de A. rizogenes 

induce la proliferación de raíces adventicias dando lugar a la enfermedad denominada raíz en cabellera.  

La infección del tejido vegetal por parte de Agrobacterium, está dada por reconocimiento de compuestos 

fenólicos (como la acetosiringona) que el tejido vegetal libera cuando se produce una herida en la planta. Estas 

moléculas señal activan el proceso de patogénesis de la bacteria y provocan su movilización hacia el tejido dañado 

por quimiotaxia.  

Para utilizar el mecanismo de Agrobacterium en la introducción de ADN en células vegetales, se han 

desarrollado vectores derivados del plásmido Ti. En estos vectores, los genes implicados en la síntesis de opinas y 

auxinas, que no son necesarios para la transferencia del T-DNA, son eliminados, dejando únicamente la región T-

DNA (Valderrama et al., 2005). Los genes vir, que codifican las proteínas encargadas de movilizar y transferir el 

T-DNA al genoma vegetal, no necesitan estar en el mismo plásmido que la región T-DNA para ser funcionales. 

Dado esto, y considerando el gran tamaño del plásmido Ti original de aproximadamente 20 kb, se han desarrollado 

estrategias para reducir el tamaño de estos vectores de transferencia. Entre los vectores que cumplen con estos 

requisitos, se encuentran los vectores de la serie pCAMBIA (Komori et al., 2007). El vector pCAMBIA contiene la 

región T-DNA recombinante en un plásmido pequeño, que se utiliza en conjunto con un plásmido helper que 

contiene los genes vir necesarios para mediar la transferencia al genoma vegetal. 

 

1.1.3 Selección de transformantes 

Debido a que solamente un porcentaje muy bajo de células incorpora el transgén en el proceso de transformación, 

es necesario recurrir a algún método para poder distinguirlas y seleccionarlas de las células no transformadas. Como 

estrategia se utiliza la incorporación de genes en el vector de transformación que, al expresarse en la célula 

transgénica, puedan conferir una ventaja en un medio selectivo (genes marcadores de selección) respecto a las 

células no transformadas, o permitir una selección visual (genes reporteros) mediante cambios fenotípicos de los 

explantos transformados. 

Entre los genes de selección se encuentran aquellos que confieren resistencia a agentes selectivos como 

antibióticos y herbicidas. Los más utilizados son el gen de la neomicina fosfotransferasa (nptII) y el gen de la 

Higromicina B fosfotransferasa (hpt); el primero confiere resistencia a los antibióticos aminoglucósidos como la 
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Kanamicina, y el segundo al antibiótico Higromicina. Estos genes codifican enzimas que desintoxican los 

antibióticos a través de la fosforilación, lo que permite el crecimiento celular y la diferenciación de las células 

vegetales transformadas a brotes cuanto estas son cultivadas en medios suplementados con estos agentes selectivos 

(Nyaboga et al., 2014). En la selección de transformantes de Prunus domestica, se han utilizado tanto Kanamicina 

como Higromicina (Tian et al., 2009).  

Debido a que la respuesta del material vegetal a estos agentes puede variar según las condiciones de cultivo, el 

genotipo o el tipo de explanto (Gonzalez Padilla et al., 2003), es fundamental determinar la sensibilidad del material 

a los agentes de selección previo al procedimiento de transformación. Una dosis subóptima podría dar como 

resultado la aparición de escapes (brotes no transformados) y, por otro lado, una concentración alta del antibiótico 

podría inhibir el crecimiento de las células transformadas.  

En cuanto a los marcadores visuales más utilizados, denominados genes reporteros, se encuentran los genes uidA 

y gfp. El gen uidA, más conocido como gen gus, codifica para la enzima β-glucoronidasa que degrada el sustrato 5-

bromo-4-cloro-3-indolyl- βglucurónido (X-Gluc) produciendo un precipitado de color azul de fácil detección. La 

expresión de este gen permite el monitoreo a corto plazo de la transformación genética, mediante una reacción 

histoquímica. Esta prueba de expresión transiente se utiliza como base para la estandarización de protocolos de 

transformación (Song et al., 2011) 

En cuanto al gen gfp, éste codifica para la proteína fluorescente verde (GFP) que, al expresarse en la célula 

vegetal transformada, emite fluorescencia verde cuando se expone a luz ultravioleta. A diferencia de gus, que su 

detección implica la destrucción del tejido, gfp permite conservar vivo el material en estudio, lo que representa una 

herramienta útil para visualizar diferentes etapas del proceso de transformación (Joshi et al., 2005). 

1.2 Factores que afectan la transformación mediada por A. tumefaciens 

El desarrollo de un protocolo de transformación mediado por A. tumefaciens en especies como las del 

género Prunus, requiere la identificación de los factores que influyen tanto en la transformación genética así como 

en la regeneración de una planta entera a partir del tejido vegetal transformado. Entre los factores que pueden tener 

un efecto significativo sobre la obtención de tejido vegetal transformado genéticamente se encuentran: la variedad 

y el tipo de explanto a transformar, la cepa de A. tumefaciens, el método de inoculación, el estado fisiológico y la 

densidad bacteriana en la inoculación, el tiempo de co-cultivo, la presencia de compuestos como la acetosiringona, 

concentración del agente de selección, entre otros (Canli & Tian, 2009; Wang, 2011). 

En cuanto al tipo de explanto, se pueden utilizar dos clases: material juvenil (tejidos derivados de semillas como 

cotiledones e hipocótilos) o material adulto (por ejemplo, hojas o segmentos nodales) (Ricci et al., 2020). La 

regeneración a partir de tejidos somáticos adultos se recomienda particularmente para cultivos de propagación 
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clonal con el objetivo de mantener la estabilidad genética del clon (Song et al., 2019). Sin embargo, la mayoría de 

los procedimientos de transformación descriptos para Prunus spp. (incluyendo durazno, ciruela europea y ciruela 

japonesa) implican el uso de explantos derivados de semillas, debido a que estos explantos generalmente tienen 

tendencia a producir brotes in vitro (Petri et al., 2018). 

En la transformación de ciruelo europeo se han empleado distintas cepas, incluyendo LBA4404, EHA101, 

EHA105 y GV3101 (Song et al., 2011), y se ha informado que la efectividad de la transformación puede variar 

significativamente en función de la cepa empleada. Song et al. (2011) reportaron diferencias en la transformación 

de ciruela (tanto en transformación transiente como transformación estable) entre las cepas LBA4404 y GV3101, 

ambas con construcciones idénticas. Los resultados mostraron que la eficiencia de la cepa LBA4404 fue 22 veces 

mayor que GV3101 en la transformación estable de ciruelas, por lo que sugieren que la cepa debe considerarse 

cuidadosamente para la transformación de diferentes variedades de ciruela.  

Además de la cepa, la fase de crecimiento y la concentración del inóculo bacteriano (expresadas en términos de 

Densidad óptica OD600) pueden considerarse como otros de los factores que influyen en la transformación. La fase 

de crecimiento más utilizada es la logarítmica o exponencial, donde las bacterias se dividen rápidamente y la OD600 

se encuentra entre 0.2 y 1.0 aproximadamente (Gonzalez padilla et al., 2003). Una OD600 muy por encima de 1.0 

indica fase de latencia/declive con alto porcentaje de células muertas, no recomendada para la transformación. En 

cuanto a la concentración de la bacteria al momento de inocular el explanto, se ha documentado un incremento en 

la eficiencia de transformación conforme el valor de la densidad óptica disminuyó (Yu et al., 2002). Este efecto 

podría relacionarse a la necrosis producida en el explanto debido a la cantidad excesiva de células bacterianas.  

Se han desarrollado distintos métodos de inoculación para el ingreso de la bacteria al interior de los 

explantos, siendo la inmersión el más frecuente en Prunus spp., donde el explanto se sumerge en una suspensión de 

A. tumefaciens durante un tiempo que puede variar entre 20 a 60 min (Gonzalez padilla et al., 2003). Otras 

metodologías incluyen, además, la generación de heridas en el tejido para permitir el acceso de la bacteria a las 

células vegetales. Miguel & Oliveira (1999) han transformado hojas de Prunus dulcis realizando cortes 

perpendiculares a la nervadura utilizando un bisturí previamente sumergido en una suspensión de A. tumefaciens. 

La aplicación de sonicación se ha utilizado para producir heridas en el tejido, donde sola o combinada con 

infiltración al vacío ha permitido mejorar la eficiencia de transformación en muchas especies de plantas, 

especialmente aquellas que son recalcitrantes a la transformación mediada por A. tumefaciens. Pérez Caselles et al. 

(2011) obtuvieron valores más altos de transformación cuando se aplicó sonicación durante 30 s más infiltración al 

vacío durante la infección de hipocótilos de damasco. Sin embargo, la sonicación puede causar daño celular. En 

este sentido, Gao and Tao (2014) probaron diferentes tiempos de sonicación en transformación de cotiledones de 
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Prunus mume, encontrando que los explantos mostraron daños graves después del tratamiento; por lo que es 

necesario poner a punto el tratamiento para cada especie.  

En cuanto al período donde se cultiva el explanto con la bacteria, etapa de co-cultivo, el tiempo estándar para la 

mayoría de los protocolos de transformación es de 2-3 días. Periodos más prolongados de co-cultivo no son 

recomendables ya que promueven un crecimiento bacteriano excesivo, lo cual puede ser perjudicial para las células 

vegetales. Ainsley et al. (2001) demostraron que tiempos de co-cultivo mayores a 3 días resultaron en una 

colonización masiva de A. tumefaciens, causando necrosis en los tejidos que luego afecta su capacidad regenerativa 

y de transformación. 

Luego del co-cultivo, es necesario eliminar las células bacterianas residuales para evitar sobrecrecimiento y 

permitir la regeneración del tejido vegetal. Los antibióticos Cefotaxima y Timetina son comúnmente utilizados para 

este fin. La concentración debe optimizarse para cada combinación tejido vegetal/cepa bacteriana, ya que dosis 

subletales permitirían la supervivencia de A. tumefaciens mientras que dosis muy altas pueden resultar fitotóxicas 

e inhibir la regeneración. 

La adición de acetosiringona durante la inoculación y co-cultivo de los explantos con A. tumefaciens fue 

reportado como un potenciador de la eficiencia de transformación. Esto se debe a que la acetosiringona estimula la 

transcripción de los genes vir facilitando la transferencia del T-DNA (Tzfira y Citovski 2006). En especies de 

Prunus como el damasco (Laimer da Câmara Machado et al., 1992) y el almendro (Miguel & Oliveira, 1999), se 

ha observado un efecto potenciador de la acetosiringona durante la transformación mediada por A. tumefaciens.  

En ciruelo europeo las eficiencias de transformación se han reportado con una ocurrencia desde 0,4 % (Padilla 

et al., 2013) hasta 42 % (Petri et al., 2008) de explantos transformados. Asimismo, los factores mencionados 

previamente han sido reportados como influyentes en la transformación mediada por A. tumefaciens. Por lo tanto, 

aquellos protocolos que busquen optimizar la eficiencia de transformación deben estudiar dichos factores en un 

diseño experimental que permita evaluar el efecto individual de cada factor y la interacción entre ellos, con el 

objetivo final de definir la mejor combinación de factores que maximice la transformación.  

En este trabajo, se busca construir vectores para la transformación genética, así como poner a punto la 

transformación genética transiente de cotiledones de ciruelo europeo ‘D´Agen’ mediante la identificación de 

factores claves que influyen en la transformación mediada por A. tumefaciens. Se estudió el efecto del estado 

fisiológico de la bacteria, la sonicación y la aplicación de vacío, sobre la expresión transiente del gen GUS. La 

estandarización de un protocolo reproducible y de alta eficiencia permitiría acelerar los programas de mejoramiento 

genético en esta especie para obtener nuevos cultivares elite con características agronómicas deseadas.  
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2 HIPÓTESIS 

La aplicación de vacío y sonicación durante la infección con A. tumefaciens C58C1, así como la adición de 

acetosiringona al medio de co-cultivo, potenciarán la transformación transiente de cotiledones de Prunus domestica 

cv. ‘D’Agen’. 

 

3 OBJETIVOS 

Objetivo general 

Optimizar la transformación genética mediada por A. tumefaciens C58C1 de cotiledones de ciruelo europeo 'D'Agen' 

y desarrollar un vector para la transformación genética de esta especie que incorpore la tecnología Fastrack 

Breeding, para obtener nuevas variedades con características deseables en un menor tiempo. 

Objetivos específicos 

I. Clonar el gen ptFT1 en un vector de expresión en plantas. 

II. Evaluar el efecto de la concentración de Higromicina sobre la regeneración in vitro de brotes en cotiledones 

'D'Agen'. 

III. Determinar la sensibilidad a Cefotaxima y Timetina de A. tumefaciens. 

IV. Determinar el efecto individual e interactivo de la aplicación de vacío, sonicación y acetosiringona sobre número 

de explantos transformados y el número de eventos de transformación por explanto, en un ensayo de optimización 

de transformación transiente de cotiledones de ciruelo 'D'Agen'. 
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4 MATERIALES Y MÉTODOS 

 

4.1 Clonación del gen ptFT1 en vectores de expresión en plantas mediante sistema Gateway      

Para poder introducir el gen ptFT1 en el vector de expresión en plantas pMDC32, se realizó la reacción de 

recombinación LR del sistema GATEWAY entre el clon de entrada pDONOR201-ptFT1 (cedido por Ove Nilsson, 

Plant Umeå Plant Science Centre, Suecia), y el vector destino pMDC32 (Curtis & Grossniklaus, 2003). El diagrama 

esquemático de los vectores empleados se muestra en la Figura 5. 

 

Debido a que el vector de entrada y destino presentaban el mismo marcador de selección bacteriana (Kanamicina, 

Km), el vector recombinante de interés se aisló siguiendo la estrategia descrita por Xu & Li (2008), que aprovecha 

el hecho de que los vectores utilizados poseen diferentes orígenes de replicación. El vector binario pMDC32 

contiene los orígenes de replicación Col E1 y pVS1 para E. coli y A. tumefaciens, respectivamente. Por el contrario, 

el vector pDONOR-ptFT1 solo puede replicarse en E. coli. La estrategia empleada se detalla en la Figura 6.   

 

 

 

 

Figura 5. Mapa lineal de los vectores utilizados en la reacción de recombinación LR. A) Clon de 

entrada pDONOR201-ptFT1 que porta el gen ptFT1 flanqueado por los sitios attL. B) Vector binario 

pMDC32 que contiene el gen letal ccdB flanqueado por los sitios attR. 
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4.1.1 Reacción de recombinación LR 

En un microtubo de 200 μl se añadieron, a temperatura ambiente (TA), 0,5 μl del clon de entrada pDONOR201-

ptFT1, 1,5 μl del vector destino pMDC32, 6 μl de buffer TE (pH= 8,0). Se adicionó 2 μl de enzimas LR Clonase™, 

se mezcló brevemente en vórtex y se incubó en termociclador a 25 °C durante 1 h. Luego, para detener la reacción, 

se añadió 1 μl de la proteinasa K, se mezcló brevemente y se incubó a 37 °C durante 10 min.   

De esta mezcla de reacción se tomaron 2 μl para transformar mediante choque térmico (Anexo 2) 100 µl de células 

químicamente competentes de E. coli DH5α. Posteriormente, las células se suspendieron en medio LB líquido 

suplementado con Km (50 mg/l) y se incubaron a 37 °C overnight (ON). La extracción de ADN plasmídico se 

realizó mediante un kit de extracción (High-Speed Plasmid Mini Kit, Geneaid) siguiendo las instrucciones del 

fabricante y se corroboró mediante electroforesis en gel de agarosa al 1 % (p/v) teñido con Bromuro de Etidio (BrEt) 

a una concentración final de 0,5 µg/ml. La corrida electroforética se llevó a cabo durante 10 min a 90 voltios (V) 

más 45 min a 65 V. Transcurrido ese tiempo, el gel fue visualizado en un transiluminador de luz ultravioleta 

(GeneFlash, Syngene) y se realizó registro fotográfico para su posterior interpretación. En este punto se esperaba 

Figura 6. Esquema utilizado para la obtención del vector binario recombinante utilizando 

la tecnología de clonación Gateway®. Col E1 ori: origen de replicación para E. coli. pVS1 ori: 

origen de replicación para Agrobacterium. Kan r: gen de resistencia a Kanamicina. RB: borde 

derecho de T-DNA. LB: borde izquierdo de T-DNA. att L, att R, att B: sitios de 

recombinación. ccdB: gen ccdB de E. coli. Fuente: adaptado de Xu & Li (2008). 
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obtener el siguiente patrón de bandeo correspondiente a la mezcla de vectores: pDONOR201-ptFT1 sin reaccionar 

de 2000 pb y el vector de expresión recombinante pMDC32-ptFT1 de 10.963 pb. 

Para seleccionar el clon de expresión recombinante, se transformaron células químicamente competentes de la 

cepa C58C1 de A. tumefaciens con 5 μl de la mezcla de ADN plasmídico extraída del cultivo líquido de E. coli, 

siguiendo la metodología descrita en el Anexo 2. Al cabo de aprox. 48 h de incubación a 28 °C, se seleccionó una 

de las colonias que crecieron en medio selectivo LB suplementado con Tetraciclina (Tc) 2,5 mg/l y Km 50 mg/l y 

se realizó un cultivo líquido en agitación ON con el objetivo de extraer el plásmido recombinante de interés y 

criopreservar las bacterias transformantes a -80 °C en glicerol al 20 %.  

La corroboración de la extracción de ADN plasmídico de interés de A. tumefaciens se realizó mediante 

electroforesis como se describió previamente para E. coli. Posteriormente, se realizaron PCRs (convencionales y 

Colony PCRs) para confirmar la presencia del vector pMDC32-ptFT1 utilizando los cebadores directo 5’ 

TCATTTCATTTGGAGAGGACCTC3’ y reverso, 5’GCGCTATATTTTGTTTTCTATCG3’ que amplifican un 

fragmento de 1263 pb (Figura 7). Como control positivo se utilizó el vector pMDC32-OLE, que contiene un 

fragmento en el sitio de clonado (Sánchez et al., resultados no publicados) esperando un amplicón de 1900 pb con 

los cebadores directo y reverso utilizados para la amplificación de pMDC32-ptFT1. 
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Las reacciones de amplificación se llevaron a cabo en un volumen final de 20 μl conteniendo 1 X buffer Taq 

Pegasus (provisto por el fabricante de la enzima, PB-L), 1,5 mM de MgCl2, 0,2 mM dNTPS, 0,2 µM cebador 

forward, 0,2 µM cebador reverse, 2,5 U enzima Taq polimerasa (TAQ Pegasus), 0,5 µl de ADN plasmídico y H20 

para llevar a volumen.  En cuanto a las Colony PCRs, la técnica consistió en recolectar, con un palillo estéril una 

colonia crecida en medio selectivo y utilizarla como templado en la reacción. El programa de amplificación consistió 

en un ciclo a 95 °C/5 min, 35 ciclos de 94 °C/30 s; 47 °C/30 s; 72 °C/2 min; y un ciclo de extensión final de 72 

°C/10 min. 

4.2 Evaluación de sensibilidad a Higromicina de cotiledones de ciruelo 'D'Agen' 

Preparación del explanto 

Se recolectaron frutos maduros de ciruelo ‘D´Agen’ localizado en la EEA San Pedro del INTA durante el mes 

de enero 2022. Los carozos separados de la pulpa fueron desinfectados superficialmente mediante inmersión en 1,2 

g/l hipoclorito de sodio durante 45-60 min. Posteriormente, se colocaron sobre papel secante a TA y, una vez secos, 

fueron almacenados a 4 °C hasta su empleo.  

Figura 7. Región amplificada del pMD32-ptFT1 con los cebadores 

35S_pMDC32_ptFT1_F y NosTerm_R. Mediante este par de cebadores se 

obtiene un producto de amplificación de 1263 pb. 
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Las semillas se extrajeron de los carozos con ayuda de una pinza y la desinfección superficial se realizó por 

inmersión en hipoclorito de sodio 1,2 g/l durante 20 min y agitación constante. Luego, fueron llevadas a cámara de 

flujo laminar donde se realizaron cinco lavados con H2O bidestilada estéril (H2Od), eliminando así el resto de los 

compuestos químicos (Figura 8). Las semillas se mantuvieron en H2Od ON y al día siguiente con ayuda de un bisturí 

se eliminó el tegumento y se separó el hipocótilo del cotiledón. 

 

 

 

 

 

 

 

 

 

 

 

 

Preparación de medios y evaluación de la regeneración de brotes en medio selectivo 

El protocolo de inducción de brotes a partir de cotiledones consistió en la utilización de dos medios de cultivo 

SRM (del inglés Shoot Regeneration Medium): i) SRM con 2,4-D y ii) SRM sin 2,4-D. El medio SRM con 2,4-D 

estaba formulado por sales de medio MS ¾ X (¾ MS, Murashige & Skoog, 1962), vitaminas MS 5 X, sacarosa 20 

g/l, agar 6,5 g/l (BRITANIA®, CABA, Argentina), pH 5,8 y los reguladores de crecimiento vegetal (RCV): 

tidiazurón (TDZ) 75 μM, ácido indol-3-butírico (IBA) 0,25 μM y ácido 2,4-diclorofenoxiacético (2, 4-D) 9 μM. La 

composición del SRM sin 2,4-D era similar al SRM con 2,4-D con la excepción de no estar suplementado con 2,4-

D y tener una concentración final de agar a 9 g/l. El pH de los medios se ajustó previo a la esterilización del medio 

en autoclave a 121 °C y a 1 atmósfera de presión durante 20 min. En cuanto a los RCV, por tratarse de compuestos 

termolábiles, éstos se filtraron empleando un filtro de jeringa de 0,20 μm y se agregaron al medio posterior a la 

esterilización del mismo.  

Figura 8. Desinfección de semillas de ciruelo. A) Extracción de la semilla del carozo. 

B) Desinfección en una solución de hipoclorito de sodio en agitación. C)  Lavado en 

H20d en cámara de flujo horizontal. 
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Los cotiledones se dispusieron en placas de Petri con la superficie adaxial en contacto con el medio SRM con 

2,4-D y fueron mantenidos en el mismo durante tres días en cámara de cultivo a 24 ± 2 °C y un régimen diario de 

16 h luz y 8 h de oscuridad. Transcurrido este tiempo, los cotiledones se transfirieron al medio SRM sin 2,4-D, 

suplementado con distintas concentraciones del antibiótico Higromicina (Hyg) para determinar la concentración 

mínima a la cual se inhibe la regeneración in vitro de brotes en medio selectivo. Los tratamientos quedaron definidos 

por seis concentraciones de Hyg: 0; 1,5; 2,5; 5; 10; y 20 mg/l (Tian et al.,2009), cuyas unidades experimentales 

consistieron en una placa de Petri con 25 ml de medio y un n= 20 cotiledones.  

Los brotes regenerados fueron clasificados en dos tipos: brotes tipo I y brotes tipo II. Esta clasificación se realizó 

en base al conocimiento previo del grupo de biotecnología sobre la regeneración in vitro de ‘D’Agen‘, en la que 

generalmente los brotes tipo II son los que progresan en las etapas posteriores, a la inducción de brotes, en el cultivo 

in vitro. Por este motivo, se analizó particularmente el efecto de la Hyg en la regeneración de brotes tipo II. 

Asimismo, se evaluó el efecto de la Hyg, sobre tres variables respuesta asociadas a la regeneración de brotes en 

condiciones in vitro en medio selectivo: i) porcentaje de brotación (N° de explantos con brotes/ N° de explantos 

totales), ii) porcentaje de explantos necrosados y iii) porcentaje de explantos blanqueados. La evaluación se realizó 

a los 28 días luego de iniciado el ensayo.   

Análisis estadístico 

Se realizó un análisis de correlación de Pearson para evaluar la asociación entre la variable independiente 

concentración de Higromicina (ccHyg) y las variables respuestas: porcentaje de regeneración, porcentaje de 

explantos necróticos (oxidados) y porcentaje de explantos blanqueados. También se ajustaron modelos de regresión 

lineal simple para evaluar el efecto de la ccHyg sobre cada una de las variables respuesta. Todos los análisis se 

realizaron con el programa estadístico InfoStat versión 2020 (Di Rienzo et al. 2020). 

4.3  Optimización de la transformación 

4.3.1 Vector pCAMBIA2301  

Para la transformación de cotiledones de ciruelo se utilizó el vector binario pCAMBIA2301 que contiene el gen 

reportero GUS (uidA), el promotor constitutivo CaMV 35S, el terminador de nopalina sintasa (NOS), el promotor 

lacZa y genes de selección de Kanamicina nptII (neomicina fosfotransferasa II) tanto para bacterias como para 

plantas (Figura 9). 
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4.3.2 Transformación bacteriana 

Uno de los factores que influye en la eficiencia de la transformación mediada por A. tumefaciens es la cepa (Song 

et al., 2011). Para seleccionar aquella con la que se iban a realizar los experimentos de transformación genética de 

explantos de ‘D’Agen’ (sección 4.4), se decidió transformar cinco cepas de A. tumefaciens (Tabla 1) con el vector 

pCAMBIA2301 aislado previamente. Asimismo, se transformó la cepa DH5α de E. coli que luego se criopreservó 

en glicerol al 20 % (v/v) a -80°C con el objetivo de conservar el vector por largos períodos de tiempo en una cepa 

con elevada tasa de replicación de ADN plasmídico.  

 

 
 

 
 

 
 

 

 

Figura 9. Mapa del vector pCAMBIA2301. Se muestran los diferentes elementos que componen la 

región T-DNA: Bordes izquierdo (LB) y derecho (RB); CaMV 35S promoter: promotor constitutivo del 

virus del mosaico del coliflor; NeoR/KanR: gen que confiere resistencia a antibióticos aminoglicósidos 

en plantas; NOS term: Terminador de la nopalina sintasa; GUS: gen que codifica la enzima β-

glucoronidasa. Por fuera de la región T-DNA se encuentra el gen KanR, que confiere resistencia a 

Kanamicina en bacterias. 
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Para llevar a cabo la transformación bacteriana se utilizó la metodología de choque térmico de células 

químicamente competentes obtenidas con CaCl2 (Anexo 3). Se utilizó 10 µl de la extracción del plásmido 

pCAMBIA2301 para transformar las cepas de A. tumefaciens y 5 µl para E. coli. La selección de las colonias 

bacterianas que incorporaron el plásmido de interés (transformantes) se realizó haciendo crecer las bacterias en 

medio LB con Km 50 mg/l.  

  Reacción en cadena de la Polimerasa (PCR) 

Se realizó una Colony PCR para confirmar la presencia del vector pCAMBIA2301 en las colonias crecidas en 

el medio selectivo utilizando un par de cebadores específicos para el gen nptII que generan un amplicón de 260 pb 

(forward 5´-CTGGACGAAGAGCATCAGGG-3´ y reverse 5´-TAAAGCACGAGGAAGCGGTC-3´). Como 

control negativo se utilizaron las cepas “vacías”, es decir, aquellas que no estaban provistas del vector 

pCAMBIA2301. Las amplificaciones se llevaron a cabo en un volumen final de 20 μl con 1 X de buffer PB-L 

(Productos Bio-Lógicos), 1,5 mM de MgCl2, 0,2 mM de cada dNTPS, 0,2 µM de cebador forward, 0,2 µM de 

cebador reverse, 1 U de la enzima Taq polimerasa Pegasus (PB-L) y H20d hasta completar volumen. Se recolectó 

una colonia utilizando un tip de pipeta estéril y se resuspendió en la mezcla de reacción. Se utilizó como programa 

de amplificación un ciclo de desnaturalización inicial a 95 °C/5 min, 35 ciclos de 94 °C/30 s; 58 °C/30 s; 72 °C/30 

s; y un ciclo de extensión final de 72°C/10 min. 

4.3.3  Evaluación del efecto de los antibióticos sobre el crecimiento de las cepas de A. 

tumefaciens. 

En los experimentos de transformación genética mediada por A. tumefaciens, la bacteria debe ser eliminada del 

explanto vegetal luego del período de co-cultivo. Para ello, se evaluó el efecto de la concentración de Timetina y 

Cefotaxima sobre el crecimiento en placa de las cinco cepas de A. tumefaciens (Tabla 1) transformadas con el vector 

  

 

  

 

  

 

  

 Tabla 1. Resistencia a antibióticos de las cepas de A. tumefanciens empleadas para la 

transformación bacteriana con el vector pCAMBIA2301. 
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pCAMBIA2301. La técnica empleada consistió en sembrar el inóculo mediante estriado en placas de Petri con 

medio LB suplementado con los antibióticos correspondientes según cepa y concentraciones diferentes e 

independientes de Timetina y Cefotaxima.  El efecto de la concentración se evaluó a seis niveles: 0, 75, 150, 200, 

300 y 400 mg/l para Timetina y a 0, 100, 200, 300, 500 y 600 mg/l en el caso de Cefotaxima. El orden de siembra 

de las cepas en la placa de Petri se describe en la Figura 10. Las placas se incubaron en estufa a 28 °C y el crecimiento 

bacteriano se evaluó a los tres días posteriores a la siembra. 

 

 

 

 

 

 

 

 

 

 

 

 

 

4.3.4 Ensayos de transformación 

4.3.4.1 Preparación de inóculo bacteriano 

 

Las cepas C58C1 de A. tumefaciens, vacía y transformada con el vector binario pCAMBIA2301, se 

seleccionaron para los ensayos de transformación de tejido vegetal de ‘D’Agen’ (sección 4.3). 

Se inoculó una colonia bacteriana en 5 ml de medio LB suplementado con TC (2,5 mg/l) y se incubó ON a 28 

°C en un agitador orbital. A partir de este cultivo, se realizó una dilución 1/100 en 50 ml finales de medio LB. Ésta 

se llevó a cabo en un erlenmeyer de 250 ml, tomando una relación de aireación (1/5), y se incubó ON a 28 °C en 

 

Figura 10. Distribución de la siembra de las cepas de A. tumefaciens para 

evaluar sensibilidad a Cefotaxima y Timetina.  
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agitación hasta la OD de ensayo medida mediante la absorbancia a 660nm en espectrofotómetro LAMBDA 25 

(PerkinElmer). En cuanto al cultivo de la cepa transformada, el medio LB utilizado fue, a su vez, suplementado con 

50 mg/l de Km, debido a la resistencia conferida por el vector. Por último, se centrifugó a 2500 x g durante 5 min, 

se descartó el sobrenadante y el sedimento se resuspendió en medio de transformación (SRM líquido con 

Acetosiringona 100 µM) hasta una OD600= 0,3 (OD de infección) y se mantuvo a 28 °C en agitación suave durante 

un mínimo de 4 h. 

4.3.4.2       Expresión transiente en hojas y puesta a punto de la tinción GUS 

El ensayo se llevó a cabo para establecer las condiciones de transformación que maximizan el número de 

explantos transformados y número de eventos transformantes/explanto (variables respuesta) en la transformación 

transiente de hojas de ‘D’Agen’. Para ello se empleó un diseño experimental Screening multifactorial 23 = 8 

tratamientos, en el que se evaluaron tres factores a dos niveles cada uno (Tabla 2). La cepa C58C1 vacía se utilizó 

como control negativo de transformación.  

 

 

 

 

 

 

 

 

 

Las hojas expandidas y turgentes empleadas para este ensayo fueron escindidas de brotes de ‘D’Agen’ 

mantenidos en condiciones in vitro y colocadas en medio SRM líquido (SRM líq.), antes de iniciar cada tratamiento. 

La unidad experimental quedó definida por tres hojas/tratamiento.  

En los tratamientos con sonicación (ocho tratamientos), las hojas en medio SRM líq. fueron sometidas a 

sonicación (frecuencia 40 KHz) durante 15 s y posteriormente infectadas durante 15 min, sumergiéndolas en el 

cultivo bacteriano descrito anteriormente. 

 Tabla 2. Factores evaluados en el ensayo de transformación 

transiente en cotiledones 'D'Agen', y sus respectivos niveles. 

  



33 

 

Para evaluar el efecto de la aplicación de vacío sobre hojas expuestas previamente o no a sonicación, se aplicó 

vacío a una presión de -50 cm Hg durante la infección de 15 min de las hojas por inmersión en el cultivo bacteriano. 

Luego de realizados los tratamientos, las hojas fueron secadas en papel absorbente estéril para eliminar el exceso 

de la bacteria y se colocaron en placas de Petri con medio de co-cultivo (SRM) donde permanecieron en cámara de 

cultivo durante tres días a 24 ± 2 °C y en oscuridad.  

Finalizado el período de co-cultivo, las hojas se lavaron con el buffer de reacción (Anexo 5) y luego fueron 

sumergidas en el buffer de reacción GUS que contenía el reactivo x-gluc.  Dado que la presencia de la cutícula en 

la hoja podría impedir el ingreso del reactivo X-Gluc al tejido foliar durante la tinción, en ocho tratamientos del 

diseño se aplicó vacío durante la tinción GUS; éste consistió en aplicar vacío a las hojas embebidas en el buffer de 

reacción X- Gluc, a una presión de -50 cm Hg durante 5 min. 

Las unidades experimentales de todos los tratamientos fueron incubadas a 37 °C ON. Finalizado este tiempo, se 

realizó una serie lavados en etanol al 70 % (v/v) hasta eliminar la clorofila para poder visualizar las zonas 

transformadas (azul) con mayor claridad.  

Las variables respuesta evaluadas fueron: porcentaje de explantos transformados (N° de hojas que presentaron 

al menos un evento de transformación/N° de hojas totales) y N° de eventos por explanto. Como evento de 

transformación se consideró la presencia de puntos azules en el explanto (spot). Para el análisis estadístico se utilizó 

el software Design Expert versión 7.0.0. 

4.3.4.3 Ensayo de optimización de la transformación transiente en cotiledones 

 

Se empleó un diseño experimental Full- factorial, compuesto por un total de 24 tratamientos, en el que se evaluó 

el efecto de cuatro factores sobre la eficiencia de la transformación transiente de cotiledones de ciruelo 'D'Agen' 

(Tabla 3). Al igual que en el ensayo de transformación transiente de hojas, se incluyó la cepa C58C1 vacía como 

control negativo de transformación. La unidad experimental quedó definida por tres cotiledones por tratamiento.  
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Se utilizaron semillas maduras de ciruelo 'D'Agen' preparadas siguiendo el procedimiento descrito previamente 

en la sección 4.2. Luego de la eliminación del tegumento, con la ayuda de un bisturí, se realizaron tres cortes 

transversales en la superficie adaxial del cotiledón. Con el fin de evaluar el efecto de la sonicación, los cotiledones 

obtenidos fueron divididos en dos grupos: uno de ellos fue sumergido en medio SRM líquido y sonicado durante 

15 s, mientras que el otro grupo se mantuvo en el mismo medio, pero sin sonicar.  

Para evaluar el efecto de la fase de crecimiento bacteriana, se obtuvieron tres cultivos de A. tumefaciens con una 

OD600 de 0,2, 0,6 y 0,8, respectivamente. Por otra parte, la cepa vacía se cultivó hasta una OD600 de 0,4. Los cultivos 

fueron centrifugados a TA y luego resuspendidos en medio de transformación (SRM líquido, 100 µM de AS) hasta 

obtener una OD600 final de 0,3 (OD600 de infección). Los cotiledones fueron sumergidos en estas suspensiones 

bacterianas e incubados durante 20 minutos a TA para permitir la infección. Asimismo, durante la infección, parte 

de los cotiledones fueron sometidos a vacío a una presión de -50 cm Hg durante 20 min. 

Finalizada la infección, todos los cotiledones fueron secados en papel absorbente estéril para eliminar el exceso 

de la bacteria y transferidos a placas de Petri con medio de co-cultivo SRM suplementado o no con 100 µM de AS. 

Las placas se incubaron a 24 ± 2 °C en oscuridad durante tres días. 

  

  
Tabla 3. Factores evaluados en el ensayo de transformación 

transiente en cotiledones 'D'Agen', y sus respectivos niveles. 
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El esquema del diseño experimental empleado se detalla en la Figura 11. Los resultados fueron analizados 

mediante el paquete Design Expert versión 7.0.0.   

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

4.3.4.4 Detección y evaluación del gen uidA (GUS) 

Luego del período de co-cultivo, se procedió a la detección histoquímica de GUS en los explantos. La misma se 

detalla en Anexo 5. 

Para el análisis de la expresión de GUS en los cotiledones, los mismos fueron fotografiados en ambas caras, 

adaxial y abaxial, utilizando una cámara digital acoplada a un Microscopio estéreoscopico Zeiss Stemi 305 puesto 

Figura 11. Esquema del diseño experimental multifactorial para la optimización de la 

transformación transiente de cotiledones de ciruelo ‘D´Agen’ mediante A. tumefaciens. Los 

factores evaluados fueron: sonicación, fase de crecimiento bacteriana (los niveles 1, 2 y 3 

corresponden a OD
600

 0,2; 0,6 y 0,8 respectivamente), vacío durante la infección y acetosiringona 

en co-cultivo. 
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a disposición gentilmente por el Dr. Andrés Lavore del centro de Bionvestigaciones (CEBIO, UNNOBA-CICBA). 

Las imágenes fueron capturadas a través de Cámara digital 5s Axio Cam ERc en formato TIFF y luego analizadas 

utilizando el software ImageJ (Schindelin et al., 2012). Debido a que el área total del cotiledón no cabía en el 

objetivo de la lupa, se fotografíó por partes, obteniendo al menos dos fotografías por cada cara.  

Debido a que se observó tinción azul en cotiledones de los tratamientos (cepa C58C1 provista de 

pCAMBIA2301) y los controles (cepa C58C1 vacía), se realizó el siguiente análisis de imágenes basándose en la 

metodología descrita en Béziat et al. (2017) para cuantificar la transformación: 

Todas las imágenes se convirtieron a escala de grises de 8 bits, donde los valores de intensidad de píxeles oscilan 

entre 0 (negro) y 255 (blanco). Valores más bajos se corresponden con mayor intensidad de la tinción azul en la 

imagen original. 

1. Análisis de controles: Se delimitó el área total de cada cotiledón control registrando el 

número total de píxeles y sus valores de intensidad. Luego se delimitó específicamente el área que a la 

vista se consideraba con coloración azul, registrando para esta nueva área el número total de pixeles y 

sus valores de intensidad. El menor valor de intensidad observado se estableció como umbral para ese 

control y se utilizó para determinar los valores de los tratamientos GUS, en donde se consideraron como 

positivos (GUS+) a aquellos píxeles cuyo valor de intensidad era menor al umbral (es decir, la tinción 

era más intensa que la máxima registrada en el control). En cambio, se consideraron negativos (GUS-) 

los píxeles con valores de intensidad por encima de ese umbral, es decir, misma intensidad en la tinción 

azul a la que se observó en el control (ruido observado). Para cada tratamiento GUS se utilizó como 

control su “réplica” con la cepa vacía, la cual fue sometida a las mismas condiciones experimentales 

(sonicación, vacío y AS en co-cultivo). De esta manera, los umbrales reflejan el ruido de fondo propio 

de cada tratamiento. 

2. Análisis de tratamientos GUS: Se delimitó el área total de cada cotiledón, registrando el número 

total de píxeles e intensidades de dicha área. Luego se delimitó el área que a la vista se consideraba azul 

(área azul) y se determinó el número total de píxeles e intensidades del área azul. Finalmente, considerando 

el umbral determinado previamente en el control correspondiente, se consideraron como píxeles GUS+ 

aquellos con valores de intensidad menores al umbral. 

A partir del número total de píxeles y de los píxeles GUS+ obtenidos para cada tratamiento mediante el análisis 

de imágenes, se calcularon las siguientes variables respuesta: 

-Número total de píxeles GUS+ = N° px GUS+ por tratamiento 

-Porcentaje de área GUS+ = (N° px GUS+/N° total px tratamiento) x 100 
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-Promedio porcentaje de área GUS+= (N° px GUS+ cotiledón/N° total px cotiledón)/N° cotiledones por 

tratamiento. 

-Suma porcentaje de áreas GUS+ = ∑ (N° px GUS+ cotiledón/N° total px cotiledón) por tratamiento. 

El análisis estadístico se realizó utilizando el software Design Expert versión 7.0.0. Se obtuvieron modelos 

parciales para cada variable respuesta de forma independiente y a partir de ellos se calculó la función de deseabilidad 

(D) con el fin de optimizar las variables respuestas simultáneamente. Cada variable respuesta se transformó a una 

escala adimensional de 0 a 1 (siendo 1 el valor más deseable), y luego se combinaron las deseabilidades individuales 

en una deseabilidad global que resume el comportamiento conjunto de todas las variables. 
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5 RESULTADOS Y DISCUSIÓN 

 

5.1 Obtención del vector recombinante pMDC32-ptFT1 

Como resultado de la transformación con la mezcla de la reacción LR, en medio selectivo con Km se obtuvo un 

cultivo líquido de E. coli DH5α transformantes. En la Figura 12 se muestra el patrón de bandeo obtenido de ADN 

plasmídico aislado de dicho cultivo, el cual estuvo caracterizado por: i) una banda en la región entre 9 y 23 kb, 

concordante con el tamaño esperado para el vector recombinante de interés pMDC32-ptFT1 (10.960 pb) y ii) bandas 

de tamaño coincidente con el clon de entrada sin reaccionar pDONOR-ptFT1 (2000 pb). Esto, permitió suponer que 

se obtuvo la población de bacterias transformantes esperada: un pool de E. coli DH5α conformado por bacterias 

transformantes para el vector de interés y otras para el clon de entrada sin reaccionar. 

  

 

 

 

 

 

 

 

 

 

 

 

 

 

A su vez, la mezcla de plásmidos aislados de la población de E. coli DH5α transformantes, permitió transformar 

células competentes de A. tumefaciens C58C1 y obtener colonias en medio selectivo (Figura 13-A). Nuevamente, 

 
 

 
 

 
 

 

 

Figura 12. Electroforesis en gel de agarosa 1 % (p/v) de la extracción de ADN 

plasmídico de E. coli, luego de la transformación con la mezcla de la reacción LR. 1) Se 

observa una banda de tamaño coincidente con el peso molecular del vector producto esperado 

de la reacción LR, el vector recombinante pMDC32-ptFT1, y tres bandas de menor peso 

correspondientes a las diferentes conformaciones del clon de entrada sin reaccionar. M) 

marcador de peso molecular Lambda Hind III.  
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pMDC32-ptFT1 

Nickeado 

Lineal 
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se observó una banda concordante con el tamaño esperado para el vector recombinante de interés pMDC32-ptFT1 

de 11 kb (Figura 13-B) en el perfil electroforético de la extracción de ADN plasmídico de las células C58C1 

transformantes. Sin embargo, cuando se realizaron las PCRs para confirmar la identidad del plásmido extraído, no 

se obtuvo la banda de 1263 pb esperada para PMDC32-ptFT1. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Ante este resultado, se decidió realizar una Colony PCR, a partir de una de las colonias transformadas cultivadas 

en medio selectivo, sin poder amplificar nuevamente el fragmento esperado (Figura 14). Por lo tanto, si bien se 

logró extraer un plásmido del peso molecular esperado de la cepa C58C1 transformante que adquirió resistencia a 

Km (conferida por el plásmido) no se pudo comprobar la identidad de este mediante PCR. 

 

 

  

A) B) 

 

Figura 13. Transformación de A. tumefaciens C58C1 con la extracción de plásmidos de E. 

coli. A) Las flechas indican colonias crecidas en medio LB suplementado con Tc (2,5 mg/l) y Km 

(50 mg/l) B) Electroforesis en gel de agarosa al 1 % (p/v). La flecha superior en el carril 1 muestra 

una banda de ADN genómico bacteriano, y en la flecha inferior se observa la presencia de una 

banda de aproximadamente 11.000 pb, coincidente con el clon de expresión pMDC32-ptFT1. 
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El sistema Gateway está basado en el empleo de vectores con distintos marcadores de selección para permitir la 

diferenciación de los clones recombinantes tras las reacciones BP y LR (Karimi et al., 2007). En este trabajo, el 

principal desafío de clonar el gen FT en el vector de expresión pMDC32 mediante este sistema estuvo dado en que 

los vectores utilizados en la reacción de recombinación LR tenían el mismo marcador de selección bacteriana, la 

resistencia a Kanamicina. Cuando ocurre esto es difícil, si no a veces imposible, utilizar la resistencia a los 

antibióticos para seleccionar los transformantes deseados. Por ello, se propuso utilizar la estrategia propuesta por 

Xu & Li (2008) que permite superar esta limitación al aprovechar las diferencias en los orígenes de replicación de 

los vectores donante y destino para E. coli y A. tumefaciens. Ellos encontraron que al transformar A. tumefaciens 

competentes directamente con la mezcla de reacción LR, el 100% de los clones analizados contenían el vector 

2322 pb 
2027 pb 

3 M 2 1 

 
 

 
 

 
 

 

 

Figura 14. Electroforesis en gel de agarosa para confirmar mediante PCR la 

presencia del vector recombinante pMDC32-ptFT1 en colonia de A. tumefaciens 

C58C1 aislada en medio selectivo. M) marcador de peso molecular. 1) Control negativo 

2) Control positivo pMDC32-OLE 3) pMDC32-ptFT1. 
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recombinante buscado. Esto se debería a la inhabilidad de replicación de los clones de entrada en A. tumefaciens 

por diferencias en los orígenes. Por lo tanto, cuando se transforma la mezcla LR directamente en A. tumefaciens, 

estos vectores no son capaces de replicarse ni de conferir resistencia al antibiótico en dicha bacteria. 

Siguiendo este método, obtuvimos colonias de A. tumefaciens resistentes a Kanamicina tras la transformación 

con la mezcla de reacción LR, de las cuales aislamos un plásmido del tamaño esperado para el vector pMDC32-

ptFT1. Sin embargo, la identidad del mismo no pudo ser confirmada por PCR. Si bien la identificación se realizó 

en A. tumefaciens, lo óptimo hubiese sido verificar previamente la presencia del vector de interés en la mezcla LR 

proveniente de la extracción de ADN del cultivo de E. coli utilizado para la transformación. De esta manera, se 

hubiese podido confirmar desde un inicio la obtención del plásmido deseado antes de continuar con la 

transformación de A. tumefaciens. Para experimentos futuros, se sugiere incluir este paso de control por PCR en E. 

coli luego de obtener el producto de recombinación y previo a la transformación en A. tumefaciens, y además, luego 

de la transformación de A. tumefaciens, corroborar más de una colonia transformante.  

Otra de las confirmaciones a realizar sería la identidad del vector pDONOR201-ptFT1, el cual es el utilizado como 

vector donante para obtener el pMDC32-ptFT1 mediante diferentes técnicas como antibiograma, digestión con 

diferentes enzimas de restricción, o PCR seguido de la secuenciación del gen de interés. 

En relación a los resultados obtenidos, una posible explicación para la dificultad en la detección del vector sería que 

el vector sufrió una mutación en la zona en el sitio de hibridación de los cebadores durante la manipulación, por lo 

cual no permite la amplificación por PCR.  

Para corroborar esta hipótesis, se deberán diseñar nuevos cebadores que hibriden en un sitio distinto que permita 

la detección del vector. Además, en futuros ensayos se podría emplear una estrategia adicional, como la digestión 

del vector aislado con enzimas de restricción y la secuenciación por Sanger para confirmar la estructura primaria. 

Para ello, será necesario disponer de cebadores específicos que permitan obtener la secuencia del cassette de 

expresión. Una vez confirmada la obtención del vector pMDC32-ptFT, se podrá continuar con la incorporación de 

este gen en ciruelos y en otros frutales como duraznero con el objetivo de acelerar su proceso de mejoramiento 

genético. 

 

5.2 Evaluación de sensibilidad a Higromicina de cotiledones de ciruelo 'D'Agen'      

En el análisis de los cotiledones se distinguieron dos clases de brotes, identificados como “brotes tipo I”, y 

“brotes tipo II”. Los brotes de tipo I presentaron tamaño reducido, sin el desarrollo de hojas alargadas; en contraste, 

los brotes de tipo II presentaron mayor tamaño, con hojas alargadas y vigorosas. Además de los dos tipos de brote, 

se observaron efectos deletéreos en los cotiledones evaluados, como necrosis y blanqueamiento (Figura 15-A). El 
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análisis de correlación de Pearson mostró una correlación significativa entre la concentración de Hyg y estas 

variables estudiadas (Tabla 4). 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
 

 
 

 
 

 

 
 

 

Tabla 4. Análisis de Correlación de Pearson entre la concentración de Higromicina y los porcentajes 

de Regeneración, Necrosis, blanqueamiento y Regeneración de brotes tipo II de cotiledones 'D'Agen'.  

  

  

  

  

  

  

  

  

  

  

  

  

  

  

  

    

Figura 15. Efecto de la concentración de Higromicina sobre la regeneración in vitro de cotiledones 

‘D´Agen’. A)  Tipos de brote y efectos deletéreos observados durante la regeneración. B) Porcentaje de 

cotiledones que regeneraron brotes, mostraron necrosis y presentaron blanqueamiento. C) Porcentaje de 

cotiledones regenerados, considerando brotes de tipo I y II. Barras de error muestran ±5% de variación. 
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 En cuanto al porcentaje de regeneración de los cotiledones expuestos a diferentes concentraciones de Hyg, se 

encontró un efecto inhibitorio dependiente de la concentración; se observó una reducción progresiva en el porcentaje 

de explantos que desarrollaron brotes a medida que aumentó la concentración de Hyg (Figura 15 B). Esta tendencia 

fue corroborada mediante el análisis de regresión lineal, donde se observó una asociación significativa entre la 

concentración de Hyg y el porcentaje de regeneración (R2=0,78). El análisis mostró un efecto negativo de la 

concentración de Hyg sobre la regeneración, evidenciado por un coeficiente de regresión negativo (Tabla 6).  

 El resultado observado para la regeneración de brotes tipo II fue similar al obtenido para el porcentaje de 

regeneración total. Se observó una asociación lineal negativa que se evidencia con la disminución de la regeneración 

a medida que aumenta la concentración de Hyg.  

Por otro lado, el aumento de la concentración de Hyg provocó un incremento en los porcentajes de cotiledones 

con necrosis y blanqueamiento del tejido (Tabla 5). El análisis de regresión lineal confirmó una asociación positiva 

entre concentración del antibiótico y estos efectos deletéreos sobre los explantos. 

Los resultados del análisis de Regresión lineal se presentan en la Tabla 5.  

 

 

 

 

 

 

 

 

 

 

 

 

Los resultados obtenidos sugieren que una concentración de 10 mg/l de Higromicina en los medios de 

regeneración sería la conveniente de usar en experimentos de transformación de ‘D’Agen’ ya que disminuyó de 

 

 

 
 

Tabla 1. Coeficientes de la ecuación de regresión estimada para las variables respuesta Porcentajes 

Tabla 5. Coeficientes de la ecuación de regresión estimada para las variables respuesta 

Porcentajes de regeneración, Necrosis, Blanqueamiento y Regeneración de brotes tipo II de 

cotiledones 'D'Agen'.  

-Conc. Hyg: Concentración de Higromicina; Coef Est; coeficiente estimado. E.e: Error estándar; 

LI (95%): Límite inferior del intervalo de confianza del 95%; LS (95%): Límite superior del 

intervalo de confianza del 95%; T: Valor de probabilidad T; p-valor: valor de probabilidad p 

 

Conc. Hyg: Concentración de Higromicina; Coef Est; coeficiente estimado. E.e: Error estándar; 

LI (95%): Límite inferior del intervalo de confianza del 95%; LS (95%): Límite superior del 

intervalo de confianza del 95%; T: Valor de probabilidad T; p-valor: valor de probabilidad p 

 

Conc. Hyg: Concentración de Higromicina; Coef Est; coeficiente estimado. E.e: Error estándar; 

LI (95%): Límite inferior del intervalo de confianza del 95%; LS (95%): Límite superior del 

intervalo de confianza del 95%; T: Valor de probabilidad T; p-valor: valor de probabilidad p 
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manera significativa el porcentaje de regeneración con respecto al control e inhibe completamente la regeneración 

de brotes tipo II. Sin embargo, a esta misma concentración también se observaron efectos deletéreos importantes 

sobre la regeneración de brotes no transformados.  

Como se mencionó previamente, el desafío en la utilización de los antibióticos de selección es encontrar el 

equilibrio entre la inhibición de la regeneración de brotes no transformados y el menor daño posible en el tejido 

vegetal. Si bien altas concentraciones pueden inhibir la formación de brotes no transformados, el daño excesivo al 

tejido también puede influir en la capacidad de regeneración de las pocas células transformadas. Cuando existe 

daño, las células necróticas liberan productos tóxicos que generan condiciones desfavorables para el desarrollo de 

los brotes transformados (Mokhailov et al., 2007). Es decir, no es suficiente únicamente con que no haya escapes; 

se necesita mantener la viabilidad del tejido lo máximo posible para que las células transformadas puedan regenerar. 

En base a lo mencionado, según nuestros resultados, se podría sugerir el uso de una concentración de 5 mg/l, ya 

que se observó una disminución del porcentaje de cotiledones que regeneraron brotes tipo II sin un incremento 

importante en los efectos deletéreos sobre el tejido vegetal. Esta concentración permitiría un equilibrio entre la 

inhibición de tejido no transformado y la regeneración de tejido transformado en futuros experimentos de 

transformación genética de cotiledones 'D´Agen'. Los resultados reportados por Tian et al. (2009) coinciden con 

esta sugerencia. Ellos evaluaron diferentes concentraciones de Hyg (0, 2,5, 5, 10, 20, 30 mg/l) en segmentos de 

hipocótilo de ciruela 'Stanley' y observaron que a concentraciones de 5 mg/l o mayores, no hubo regeneración de 

brotes y los explantos murieron luego de 5 semanas. Por lo tanto, utilizaron esta concentración en experimentos de 

transformación para ejercer presión de selección, concluyendo que la selección fue efectiva, sin escapes. En la 

misma línea, Mikhailov et al. (2007) establecieron que la concentración efectiva de Higromicina para la selección 

de hojas del cultivar 'Startovaya' estaba entre 7-8 mg/l. Con 15 mg/l todos los explantos mostraron necrosis severa 

y murieron sin formación de callos, y con concentraciones intermedias, 9 a 11 mg/l, lograron la formación de 

algunos callos pero luego los explantos se necrosaron gradualmente y no desarrollaron yemas. 

Es importante destacar que tanto en nuestro ensayo con cotiledones ‘D’Agen’ como en los trabajos de Tian et 

al. (2009) con hipocótilos 'Stanley' y Mikhailov et al. (2007) con hojas 'Startovaya', fue necesario utilizar 

concentraciones bajas de Higromicina para inhibir la regeneración sin producir necrosis severa (5 a 8 mg/l). Esto 

evidencia la alta sensibilidad a este antibiótico de Prunus domestica más allá del genotipo o el tejido utilizado.  

5.3 Optimización de la transformación 

5.3.1 Obtención de las cepas transformadas 

Se transformaron las cinco cepas de A. tumefaciens con el vector binario pCAMBIA2301 utilizando el protocolo 

de choque térmico. La comprobación de la transformación bacteriana se realizó mediante Colony PCR y el análisis 
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del perfil electroforético de los productos de amplificación. La electroforesis en gel de agarosa reveló la presencia 

de una banda de aproximadamente 260 pb correspondiente al tamaño del amplicón esperado para el vector 

pCAMBIA2301 en todas las cepas de A. tumefaciens transformadas, mientras que las cepas no transformadas no 

presentaron bandas (Figura 16). Estos resultados verifican que las cinco cepas de A. tumefaciens incorporaron con 

éxito el vector binario pCAMBIA2301.  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

5.4 Determinación de la sensibilidad a los antibióticos Timetina y Cefotaxima de A. tumefaciens 

transformada con pCAMBIA2301 

Los resultados de este ensayo demuestran que las cinco cepas de A. tumefaciens transformadas con el vector 

pCAMBIA2301 son sensibles a Timetina y Cefotaxima, dado que no se observó crecimiento bacteriano en todas 

las concentraciones evaluadas (Figura 17). Estos resultados indican que las concentraciones de 100 y 75 para 

  

  

 

  

  

 

  

  

 

  

  
Figura 16. Corroboración de la transformación de las cepas de A. tumefaciens 

con el vector pCAMBIA2301 (+). Se emplearon cepas sin transformar (-) como 

control negativo. 1) Marcador molecular de 100 pb. 2a) GV3101 (+) 2b) GV3101 

(-) 3a) LBA4404 (+) 3b) LBA4404 (-) 4a) AGL1 (+) 4b) AGL1 (-) 5a) EHA105 

(+) 5b) EHA105(-) 6a) C58C1 (+) 6b) C58C1(-). 
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Timetina y Cefotaxima, respectivamente, serían igualmente eficientes para controlar el crecimiento de A. 

tumefaciens en ensayos de transformación. 

  

 

 

En ensayos de transformación de especies de Prunus, durante la etapa posterior al co-cultivo, se han empleado 

concentraciones más altas de estos antibióticos; principalmente entre 200-300 mg/l tanto de Cefotaxima (Pratesi et 

al., 2003; Mikhailov & Dolgov, 2005) como de Timetina (Padilla et al., 2003; Song & Sink, 2006; Petri et al., 

2012). Particularmente en la transformación de cotiledones, Pratesi et al. (2003) emplearon 200 mg/l de cefotaxima 

en Prunus avium y Prunus armeniaca. El empleo de estas concentraciones puede deberse a la degradación del 

antibiótico durante el cultivo in vitro, por lo que debería emplearse a una concentración más alta al inicio para poder 

controlar de manera efectiva el crecimiento de A. tumefaciens hasta el repique del material vegetal.  

Además, aunque estos resultados informan sobre la sensibilidad de las cepas, se debe considerar el efecto de los 

antibióticos sobre la regeneración del material vegetal, debido a su rol en la morfogénesis in vitro (Piagnani & 

Chiozzotto, 2010). En este sentido, la cefotaxima se ha utilizado ampliamente en el cultivo de tejidos vegetales. De 

hecho, muchas especies se han regenerado en su presencia y en algunos casos incluso se demostró que mejora la 

capacidad de regeneración (Piagnani & Chiozzotto, 2010). Verma et al. (2023) encontraron que para eliminar el 

crecimiento excesivo de A. tumefaciens de las hojas cultivadas de manzana, la Cefotaxima debía emplearse a 500 

mg/l, pero a esa concentración inhibió la inducción de brotes, por lo que debieron reducirla gradualmente a 200 

 
 

Figura 9. Evaluación de la concentración (mg/l) de los antibióticos Timetina y Cefotaxima sobre 

el crecimiento de cinco cepas A. tumefaciens en medio LB sólido. 
 

Figura 10. Evaluación de la concentración (mg/l) de los antibióticos Timetina y Cefotaxima 

sobre el crecimiento de cinco cepas A. tumefaciens en medio LB sólido.  

 

 

 

 
Figura 17. Evaluación de la concentración (mg/l) de los antibióticos Timetina y Cefotaxima 

sobre el crecimiento de cinco cepas A. tumefaciens en medio LB sólido. 
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mg/l para permitir la formación de brotes. En contraste, Mikhailov & Dolgoet (2005) encontraron que este 

antibiótico en un rango de 250 a 1000 mg/l no influyó en la formación de callos ni en la regeneración de brotes 

adventicios de hojas de Prunus domestica. Asimismo, los resultados presentados por Piagnani & Chiozzotto (2010), 

confirman que la Cefotaxima en una concentración de 200 mg/l no interfiere en la morfogénesis de callos 

regenerados 'Burlat C1' de Prunus avium. Sin embargo, su poder como agente descontaminante a esa concentración 

en sus condiciones es bajo.  Ellos concluyen que se debe a la complejidad del tejido regenerado, masas morfogénicas 

con grietas, lo que impide el acceso del antibiótico y limita el contacto con la bacteria. 

En cuanto al empleo de la Timetina, también se ha estudiado su efecto sobre la capacidad morfogénica de 

distintos explantos de especies de Prunus cuando se emplea para la desinfección post-transformación. Este 

antibiótico es una mezcla de Ticarcilina, un derivado de la Penicilina, y Ácido Clavulánico (Nauerby et al. 1997) 

con actividad contra muchas bacterias gram negativas, aunque poseen actividad β-lactamasa. El rol de la Timetina 

en la morfogénesis in vitro parece estar asociada a la estructura de la Ticarcilina, que es similar a las auxinas, 

provocando un efecto de regulador de crecimiento cuando son degradados, facilitando la regeneración (Costa et al., 

2000). En este sentido, Padilla et al. (2003) encontraron un efecto positivo de esta en la regeneración de hipocótilos 

de Prunus domestica, aumentando la tasa de regeneración de brotes en un 25% en comparación al control cuando 

se adicionó a una concentración de 5 mg/l. Por otro lado, Burgos & Alburquerque (2003) probaron una 

concentración mucho mayor de Timetina 650 mg/l en hojas de Prunus armeniaca 'Helena', la cual disminuyó la 

regeneración en comparación al control sin antibióticos.  

En función de lo anteriormente expuesto, queda en evidencia que la concentración del antibiótico que se emplea 

para eliminar la bacteria después del post co-cultivo es importante debido a los efectos sobre el explanto. Por lo 

tanto, para complementar el trabajo realizado, quedaría realizar un análisis de sensibilidad a Cefotaxima y Timetina 

en los explantos que se va a transformar en ensayos de transformación futuros de ‘D’Agen’. 

5.5 Transformación de hojas      

Las hojas consideradas positivas para la transformación (GUS+) fueron aquellas que presentaron spots azules 

en la lámina (Figura 18). No se observaron spots en el tratamiento control con la cepa sin el vector (Figuras 18-A y 

18-B). Sin embargo, como se detectó tinción azul en la nervadura de las hojas (Figura 18-C), tanto de las hojas 

control como en las hojas de los tratamientos de transformación esta coloración fue desestimada como GUS+.  Los 

resultados obtenidos se detallan en la Tabla 6. 
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Figura 18. Hojas de ciruelo 'D´Agen'. A-B: Hojas transformadas con la cepa C58C1 

conteniendo el vector pCAMBIA2301 correspondientes a los tratamientos 7 y 1, 

respectivamente El círculo señala la zona transformada, observada en aumento 40 x. C: 

Expresión endógena en la nervadura de una hoja enfrentada a una cepa vacía en aumento 10 x. 

Barra: 2 mm. 

  

 

  

 

  

 

  

  

 

Tabla 6. Resultados de la transformación transiente de hojas 'D'Agen' mediado por A. 

tumefaciens C58C1. La unidad experimental para cada tratamiento quedó conformada por 3 

hojas, donde se evaluó el N° de explantos transformadas y el N° de eventos por explanto.  
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La tinción histoquímica de GUS es una técnica ampliamente utilizada para evaluar la expresión transiente y/o 

estable del gen reportero uidA en plantas y confirmar eventos positivos de transformación (Cervera et al., 2005). 

Sin embargo, para que esta técnica sea efectiva se deben optimizar diversos factores.  

Por un lado, se debe maximizar la transformación en los explantos. En este trabajo, en cinco de los ocho 

tratamientos analizados se obtuvieron transformantes. El análisis descriptivo de los datos mostró que la aplicación 

individual de sonicación, resultó ser la mejor condición para aumentar la transformación transiente en hojas de 

ciruelo ‘D’Agen’, ya que permitió obtener un mayor número de hojas transformadas y número de eventos/hoja 

Estos resultados se pueden deber a una mayor penetración de A. tumefaciens en el tejido foliar, ya que el proceso 

de sonicación genera microheridas por cavitación que facilitan el acceso de las bacterias y la transferencia de ADN-

T (Pérez-Caselles et al., 2021).  

La aplicación individual de vacío también produjo transformantes, posiblemente al mejorar la infiltración de A. 

tumefaciens en el tejido (Hada et al., 2018). Sin embargo, la combinación de sonicación y vacío no resultó en una 

mejora aditiva de la transformación, en contraste a lo esperado. Una posible explicación podría ser el efecto 

combinado de ambos tratamientos disminuye la viabilidad del tejido afectando la incorporación del transgen y por 

lo tanto reduciendo la señal de GUS+.  

A pesar de las observaciones mencionadas anteriormente en base al análisis descriptivo de los datos para cada 

tratamiento, no fue posible evaluar el efecto de los tres factores estudiados sobre las variables respuestas asociadas 

a la transformación de hojas de ciruelo 'D'Agen' en base a modelos predictivos estadísticamente significativos, dado 

que no se cumplían con los supuestos estadísticos necesarios. Se propone aumentar el número de muestras de cada 

tratamiento para confirmar los resultados observados.  

Otro aspecto importante a considerar es la posibilidad de detección de falsos positivos debido a la actividad 

endógena de la enzima GUS, que en algunas especies vegetales puede generar tinción azul inespecífica y 

confundirse con transformación positiva (Abdollahi et al., 2011). En nuestro trabajo se observó tinción inespecífica 

en zonas de la nervadura de las hojas, tanto en las hojas control como en las transformadas.  Este resultado evidencia 

la necesidad de ajustar el protocolo para diferenciar la actividad transgénica de uidA de la expresión endógena para 

los diferentes tejidos y especies. 

Además de la posibilidad de detección de falsos positivos debido a la actividad GUS endógena, también existe 

el riesgo de obtener falsos negativos por una deficiente tinción que impida detectar células transformadas. Para que 

el reactivo X-Gluc penetre en el interior de las células transformadas debe atravesar posibles barreras físicas como 

la cutícula de la hoja. Si bien la aplicación de vacío durante la tinción GUS puede ayudar a superar esta barrera, 

nuestros resultados no concuerdan con esta afirmación. Esto puede deberse a que las hojas utilizadas en el 
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experimento provenían de plantas cultivadas in vitro, las cuales tienen una pared celular delgada.  

 

5.6 Optimización de la transformación transiente en cotiledones 

En la Figura 19 se muestran cotiledones representativos luego de la tinción histoquímica de GUS. El cotiledón 

de la izquierda corresponde al tratamiento con mayor número de pixeles GUS+ definido como: OD= 0,6 + 

Acetosiringona en el medio de co-cultivo (As co), y a la derecha un cotiledón correspondiente a su control (Figura 

19-A). Como resultado de la tinción, se observó la presencia de coloración azul en cotiledones de tratamientos GUS 

(izquierda) y en controles (derecha) (Figura 19- B). 

 

 

 

 

 

 

 

 

 

 

 

 

Los resultados del análisis de las imágenes de los cotiledones se observan en la Tabla 7, donde se detallan 

los valores de las variables respuesta estudiadas, para todos los tratamientos.  

 

Figura 19. Análisis histoquímico de la expresión de GUS en cotiledones 'D´Agen'. Se muestran cotiledones 

infectados con A. tumefaciens cepa C58C1 portando el vector de expresión pCAMBIA2301 para la expresión 

de GUS (izquierda), y su control negativo infectado con A. tumefaciens cepa C58C1 sin vector (derecha). A) 

Cotiledones correspondientes al tratamiento definido por OD600= 0,6 + AS co. Barra = 2 mm B) Cotiledones 

correspondientes al tratamiento definido por OD600= 0,6, sin vacío, sin sonicación y sin AS co. Se observa 

tinción azul también en el control negativo. Barra = 1 mm. 
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     El análisis estadístico realizado sobre los datos obtenidos del análisis de imágenes permitió obtener modelos que 

explican el efecto de los factores estudiados (p<0,05) sobre las variables respuesta asociadas a la transformación 

transiente en cotiledones. 

Respecto a la variable Número de píxeles GUS+, se obtuvo un modelo conformado únicamente por los factores 

principales OD, Vacío y AS  con un R2 de 0,44 y R2 ajustado de 0,32, lo que indica que el 44 % de la variación 

observada en los datos es explicada por el modelo. El ANOVA mostró un efecto estadísticamente significativo del 

factor vacío (p<0,05) (Tabla 8).  

 

 

 

 

 

Tabla 7. Resultados de la transformación transiente de cotiledones 'D'Agen' mediado por A. 

tumefaciens C58C1. La unidad experimental para cada tratamiento quedó conformada por 3 cotiledones, 

donde se evaluó Número total de píxeles GUS+, Porcentaje de área GUS+, Promedio porcentaje de área 

GUS+ y Suma porcentaje de áreas GUS+. 
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Si bien la OD no mostró un efecto estadísticamente significativo sobre las variables respuesta (p>0,05), la 

OD600= 0,2 (OD 1) produjo un mayor N° de píxeles GUS+ respecto a las otras dos OD evaluadas (Figura 20) 

En cuanto a la aplicación de vacío, se observó que la ausencia de este factor durante la infección de los cotiledones 

con A. tumefaciens produjo un mayor número de pixeles GUS+ en comparación con la aplicación de vacío (Figura 

20). 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
 

 
 

 
 

 

 

Tabla 8. ANOVA para la variable N° de pixeles GUS+. 

Figura 20. Efecto de la OD y la aplicación de vacío sobre el N° de pixeles GUS +. 
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Al igual que el factor OD, la aplicación de Acetosiringona en co-cultivo no tuvo un efecto estadísticamente 

significativo sobre el N° de pixeles GUS+, pero de igual manera produjo un mayor N° de píxeles GUS+ respecto a 

no añadirla (Figura 21). 

  

 

 

 

 

 

 

 

 

 

 

 

El análisis de la expresión de GUS en términos del Porcentaje de área GUS+ reveló la misma tendencia 

observada en el número de pixeles GUS+; un efecto estadísticamente significativo del factor vacío (p< 0,05) (Tabla 

9). Tanto para la variable Porcentaje de Área GUS+ como para el Promedio Porcentaje de Área GUS+, los modelos 

explicaron alrededor del 40 % de la variabilidad observada (R2 ~0,4). 

 

 

 

 

 

 

 

Figura 21. Efecto de la OD y la aplicación de vacío sobre el N° de pixeles GUS +. 

Tabla 9. ANOVA para la variable Porcentaje de área GUS+. 
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En el gráfico del efecto de los factores (Figura 20) se puede ver claramente la tendencia mencionada: la ausencia 

de vacío maximiza el promedio del porcentaje de área GUS+. Además, se vuelve a observar que la OD 1, también 

maximiza la respuesta respecto al resto de densidades ópticas evaluadas.  

 

 

 

 

 

 

 

 

 

 

  

 

 

 

Tabla 10. ANOVA para la variable Promedio del % de área GUS+. 

Figura 22. Efecto de la OD y la aplicación de vacío sobre el Promedio del porcentaje 

de área GUS+. Los puntos rojos representan los valores de respuesta observados para 

cada nivel del factor OD. 
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Al igual que en el resto de las variables estudiadas, en la Suma del porcentaje de áreas GUS+, el factor vacío fue 

el único que presentó un efecto significativo (Tabla 11). 

 

 

 

 

  

 

 

Discusión 

La transformación genética mediada por A. tumefaciens es un proceso complejo que depende de múltiples 

factores. El estudio de la expresión transiente del gen reportero GUS puede ser muy útil para evaluar dichos factores 

y establecer las condiciones que maximicen la eficiencia de transformación. (Song et al., 2011). 

En este trabajo se evaluó el efecto de cuatro factores (densidad óptica bacteriana, sonicación, vacío y 

Acetosiringona en co-cultivo) sobre la expresión de GUS en cotiledones de ciruelo 'D'Agen'. 

Respecto a la densidad óptica, la OD600= 0,2 produjo los mayores valores en todas las variables, sin ser 

estadísticamente significativo. Esto coincide con lo reportado por De Clercq et al. (2002), quienes obtuvieron mayor 

expresión transitoria de GUS con un inóculo en fase logarítmica temprana. Si bien es necesario confirmar los 

resultados obtenidos, estos sugieren que una densidad óptica baja del cultivo inicial podría favorecer la 

transformación transitoria de cotiledones de ciruelo.  

En la evaluación de los factores, el hallazgo más sorprendente fue el efecto negativo de la aplicación de vacío 

durante la infección de los cotiledones, el cual disminuyó significativamente las variables repuestas analizadas 

asociadas a la expresión transitoria de GUS. Este resultado no concuerda con lo esperado, ya que en la bibliografía 

se reporta que la aplicación de vacío se presenta como un factor importante que aumenta la eficiencia de 

transformación mediada por A. tumefaciens en diversas especies vegetales (Pérez-Caselles, et al., 2021). El 

fundamento es que la aplicación de vacío facilita la eliminación del aire presente en los tejidos intercelulares, 

permitiendo una mejor penetración de la suspensión bacteriana en el tejido y por lo tanto un mayor contacto bacteria-

célula para la transferencia del T-DNA (Niazian et al., 2017). En damasco, Pérez-Caselles et al. (2021) reportaron 

un aumento del 6 % en el número de eventos transgénicos de GFP luego de la infiltración al vacío de secciones de 

Tabla 11. ANOVA para la variable Suma del porcentaje de áreas GUS+. 
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hipocótilo 'Canino' durante 20 min a una presión de -600 mm Hg. De acuerdo con nuestros resultados, en ciruelo 

ocurre un efecto contrario, lo que resalta la importancia de poner a punto las técnicas de cultivo in vitro en cada 

especie. Además, las condiciones de experimentales del cultivo in vitro pueden variar de laboratorio a laboratorio, 

por lo que la puesta punto de forma local resulta clave para lograr herramientas biotecnológicas eficientes. La 

aplicación de 15 s de sonicación tampoco aumentó los parámetros asociados a expresión transitoria de GUS, a pesar 

de que el daño mecánico facilita, en teoría, la entrada de la bacteria al tejido. La formación de heridas es un 

prerrequisito para el proceso de transformación mediante A. tumefaciens, ya que permite que la bacteria penetre 

fácilmente en el tejido y estimule también la producción de inductores de transferencia del T-DNA (Niazian et al., 

2017).  Trabajos previos han demostrado que la sonicación incrementa los parámetros asociados a transformación 

transitoria, como la expresión de GFP (Gao et al., 2014), y GUS (Wang, 2011), en comparación a controles sin 

sonicación. Gao et al. (2014) evidenciaron mayores niveles tanto transitorios como estables de GFP tras sonicación, 

con mayor intensidad y área de fluorescencia versus controles. Respecto al trabajo de Wang (2011), ellos probaron 

diferentes tiempos de sonicación en cotiledones de damasco, observando la máxima expresión de GUS cuando 

aplicaron 1 min. de sonicación (frecuencia 40 KHz). Sin embargo, notaron una reducción en la regeneración de los 

cotiledones expuestos a este tiempo de sonicación. Por ello, concluyeron que 30 s representaba el tiempo óptimo, 

mejorando los niveles de transformación transitoria sin comprometer la regeneración. Teniendo en cuenta estos 

tiempos, una de las posibles razones por las que la sonicación no fue efectiva en nuestro trabajo, fue el tiempo de 

sonicación; restaría en estudios futuros evaluar el tiempo de sonicación en la expresión transiente de GUS y en 

paralelo evaluar cómo afecta este factor a la regeneración de cotiledones de ciruelo 'D´Agen', ya que de nada serviría 

obtener altos niveles de transformación si luego esas células transformadas no regeneran.  

En cuanto al efecto combinado de la sonicación y el vacío (factor interactivo Sonicación*Vacío), si bien se ha 

reportado que la combinación de ambos ha permitido mejorar la eficiencia de la transformación en muchas especies 

de plantas, especialmente aquellas que son recalcitrantes a la transformación mediada por A. tumefaciens (Track & 

Finer et al., 1997), son pocos los trabajos que reportan el uso de sonicación y la infiltración al vacío en plantas 

leñosas. El efecto de ambos tratamientos se ha medido principalmente sobre las eficiencias de transformación 

transitoria, como por ejemplo en cotiledones de embriones cigóticos de Pinus radiata, logrando eficiencias de 

transformación transitoria del 55 % cuando los explantos fueron infiltrados al vacío durante 5 min. También se ha 

informado de que la infiltración al vacío es el factor más crítico que afecta a la eficiencia de la transformación 

transitoria en plántulas de caqui cultivadas in vitro y se ha descrito un sistema de transformación mediado por 

Agrobacterium altamente eficiente que utiliza sonicación seguida de infiltración al vacío durante 20 min (Charity 

et al., 2002). En Prunus armeniaca, Pérez-Caselles et al., (2021) reportaron que la combinación de 30 s de 

sonicación seguida de infiltración al vacío durante 20 minutos aumentó el número de eventos transgénicos de GFP 

en hipocótilos de damasco 'Canino'. Si bien son pocos los trabajos reportados, los resultados sugieren que la 
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combinación de sonicación e infiltración al vacío mejoraría la eficiencia de la transformación en plantas leñosas. 

En nuestro caso, contrario a lo reportado, no encontramos factores interactivos con efecto significativo sobre las 

variables evaluadas. Una posible explicación es que el tipo de explanto puede influir en la respuesta a estos 

tratamientos físicos. Los cotiledones podrían ser un tejido más sensible y requerir condiciones más suaves de 

sonicación/vacío en comparación a hipocótilos u otros explantos más "duros", por lo que en futuros ensayos se 

podrían evaluar distintos tiempos y condiciones de sonicación y vacío aplicados específicamente sobre cotiledones 

de ciruelo, teniendo en cuenta la posible sensibilidad diferencial de este tipo de explanto respecto a los reportados 

previamente en la literatura. 

El último factor evaluado fue la aplicación de Acetosiringona durante la etapa de co-cultivo con A. tumefaciens. 

Como se mencionó anteriormente, la AS es un compuesto fenólico que se es liberado por las células vegetales 

dañadas y que induce la expresión de los genes de vir de A. tumefaciens, potenciando su capacidad de infección 

(Stachel et al. 1985). En nuestro ensayo, al adicionar 100 μM de AS al medio de co-cultivo donde se colocaron los 

cotiledones transformados, se observó una tendencia a obtener valores más altos en las variables asociadas a la 

expresión transitoria de GUS en comparación con el tratamiento sin AS. Sin embargo, esta diferencia no fue 

estadísticamente significativa. Un resultado similar fue reportado por Mante et al. (1991), donde no encontraron un 

efecto significativo al agregar 50 μM de AS en la transformación de GUS en hipocótilos de ciruelo. Una posible 

explicación de por qué no se detectaron diferencias significativas podría estar relacionada con el tamaño de la 

muestra evaluada. Si bien se observó una tendencia hacia valores más altos con AS, es posible que el número de 

cotiledones no haya sido suficiente para detectar esas diferencias como significativas. De hecho, la tendencia sugiere 

que la AS podría favorecer la transformación. Teniendo en cuenta estos resultados, en futuros ensayos sería 

recomendable evaluar un rango más amplio de concentraciones de AS, por ejemplo de 0 a 100 μM (0, 25, 50, 75, 

100 μM), utilizando un mayor número de cotiledones. También se podría probar concentraciones superiores a 100 

μM, ya que en la literatura se reportan niveles muy variables, desde 20 μM (Tian et al., 2009) hasta 500 μM (Gao 

et al., 2010). 

Por otro lado, es posible que la adición de AS durante la inducción previa al co-cultivo sea suficiente para 

estimular los genes vir, haciendo innecesaria su aplicación en la etapa de co-cultivo (James et al., 1993). 

Alternativamente, bajo nuestras condiciones experimentales, el tejido vegetal pudo liberar niveles adecuados de 

compuestos fenólicos para activar los genes vir, por lo que la AS exógena no tendría un efecto adicional. 

     Uno de los principales hallazgos de este ensayo fue la detección de actividad GUS endógena en los 

cotiledones control de ciruelo 'D'Agen'. Esto resulta llamativo, ya que si bien se ha reportado en otras especies 

(Kosugi et al., 1990; Hodal et al., 1992) no se ha encontrado reportes previos sobre la presencia de esta enzima en 

tejidos de Prunus spp. La presencia de esta actividad en los controles generó una señal de "ruido" no esperada, que 
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condicionó la forma de determinación de la actividad GUS en los tratamientos experimentales. Su expresión podría 

estar enmascarando la actividad GUS proveniente de la transformación mediada por A. tumefaciens, dado que ambas 

generan el mismo producto de reacción (precipitado de color azul). En este sentido, también evidenciamos actividad 

GUS endógena en hojas del mismo cultivar, aunque con un patrón distinto: mientras que la enzima recombinante 

exógena se expresa en forma de spots (puntos delimitados) en la lámina foliar, la actividad endógena aparece sobre 

las nervaduras. Esta diferencia nos permitió distinguir ambas actividades cuando analizamos la transformación 

transitoria en hojas.  

Frente a este desafío, adaptamos un método de análisis digital de imágenes para cuantificar y distinguir la 

actividad enzimática endógena y recombinante utilizando el software ImagJ. Este software ha sido utilizado en 

trabajos previos para cuantificar la expresión del GUS (Béziat et al., 2017) y se basa en que la intensidad de tinción 

azul en los tejidos se correlaciona positivamente con los niveles de expresión de GUS. 

Para poder determinar el efecto de los factores y encontrar las condiciones que maximicen las variables asociadas 

a la transformación transiente de GUS, en futuros ensayos será necesario implementar estrategias para reducir o 

eliminar la actividad GUS endógena en los tejidos blanco, especialmente en cotiledones. Asimismo, con la 

optimización de este procedimiento de cuantificación y el aumento del número de explantos por tratamiento, se 

podría determinar con mayor precisión el efecto de los factores claves sobre la eficiencia de transformación en 

futuros ensayos de transformación. 
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6 CONCLUSIONES 

En este trabajo final de licenciatura se desarrollaron una serie de herramientas biotecnológicas para el 

mejoramiento de frutales. Desde la construcción de vectores, la obtención de cepas de A. tumefaciens transformadas 

con plásmidos de interés, protocolos de tinción y análisis de GUS, así como protocolos de transformación para 

ciruelo avanzando en el conocimiento de los factores claves. Del trabajo presentado en esta tesina se concluye que: 

- Se obtuvo un plásmido del tamaño esperado para el vector pMDC32-ptFT1 luego de los ensayos de 

clonación. Sin embargo, no se pudo confirmar mediante PCR que dicho plásmido contuviera efectivamente el gen 

ptFT1 clonado en el vector de expresión pMDC32.  De confirmarse la identidad del mismo, se podrá implementar 

el sistema Fastrack breeding en frutales como ciruelo y duraznero. 

- Se determinó que una concentración de 5 mg/l de Higromicina es la óptima a utilizar en ensayos de 

transformación genética de cotiledones de ciruelo ‘D’Agen’. Esta concentración representa el mejor equilibrio para 

utilizarse como agente de selección al ser capaz de inhibir parcialmente la regeneración de brotes tipo II a partir de 

tejido no transformado, sin afectar tan severamente la viabilidad del explanto. 

- Se logró la transformación de todas las cepas de A. tumefaciens con el vector pCAMBIA2301. Estas 

obtenciones permitirán, en ensayos futuros, determinar y comparar la capacidad de transformación mediada por 

cada una de las cepas mediante la evaluación de la expresión del gen marcador GUS en diferentes tejidos 

transformados, información de relevancia para la estandarización de un protocolo de transformación en el 

laboratorio de Biotecnología de la EEA SAN PEDRO.  

- Se determinó que las cinco cepas de A. tumefaciens evaluadas fueron sensibles a las concentraciones de 100 

mg/l de Timetina y 75 mg/l de Cefotaxima, observándose una inhibición completa del crecimiento bacteriano.  

- Se logró la transformación transiente de hojas de ciruelo ‘D’Agen’ infectadas con la cepa C58C1 de A. 

tumefaciens. A partir de un análisis de estadística descriptiva, se detectó que el mayor número de eventos de 

transformación se observó en el tratamiento con sonicación. Para confirmar el efecto de los factores evaluados sobre 

la eficiencia de transformación transitoria en hojas de esta especie se requerirán de ensayos con un mayor número 

de explantos.  

- Se logró la transformación transiente de cotiledones de ciruelo ‘D’Agen’ infectados con la cepa C58C1 de 

A. tumefaciens. Se obtuvieron modelos parciales para el Número total de píxeles GUS+, Porcentaje de área GUS+, 

Promedio porcentaje de área GUS+ y para la Suma porcentaje de áreas GUS+ que explican el 40 % de la variabilidad 
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observada, lo que se refleja en un valor obtenido bajo para la función deseabilidad (D). Sin embargo, en función de 

las condiciones de estudio y los resultados obtenidos, concluimos que se obtiene mayor tejido transformado en 

cotiledones cuando estos se someten a infección con A. tumefaciens en ausencia de vacío. 
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ANEXOS 

Anexo 1. Preparación de E. coli DH5α químicamente competentes 

1) Inocular una colonia bacteriana en 10 ml de LB fresco e incubar ON a 37 °C hasta una OD600 = 0,4-

0,7. 

2) Incubar las bacterias durante 10 min en hielo. 

3) Centrifugar a 4000 rpm por 7 min a 5 °C. 

4) Descartar el sobrenadante y resuspender gentilmente el pellet en 1 ml de CaCl2 0,1 M.  

5) Incubar la suspensión por 10 min en hielo. 

6) Centrifugar a 2500 rpm durante 5 min a 5 °C y luego de descartar el sobrenadante. 

7) Añadir 1 ml de CaCl2 0,1 M frío.  

8) Distribuir las células competentes en alícuotas de 100 µl en microtubos de 1,5 ml tipo                       

Eppendorf y conservar a -80 °C. 

Anexo 2.  Transformación genética de E. coli mediante choque térmico 

1) Tomar 100 µl de bacterias competentes e incubar en hielo hasta que se descongelen. 

2) Añadir 5-20 ng de ADN plasmídico e incubar durante 30 min en hielo. 

3) Incubar durante 45 s a 42 °C (choque térmico). 

4) Añadir 1 ml de medio LB líquido sin antibiótico e incubar a 37ºC en agitación suave durante 60 

min. 

5) Centrifugar a 4000 x g durante 5 min. 

6) Resuspender el sedimento celular en 100 µl de medio LB. 

7) Esparcir con espátula de Drigalski la suspensión bacteriana sobre una placa con medio LB con 

antibiótico e incubar a 37 °C ON.   

 

El esquema de la figura 23 ilustra los pasos del protocolo de transformación E. coli y de A. tumefaciens 

(Anexo 4) utilizado en este trabajo.  
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Anexo 3.  Preparación de A. tumefaciens químicamente competentes 

1) Inocular una colonia bacteriana en 5ml de medio LB líquido con los antibióticos correspondientes 

e incubar ON a 28 °C. 

2) Inocular 50 ml de medio LB (con los antibióticos correspondientes) con 500 µl del cultivo del punto 

1. Dejar crecer a 28 °C en agitación ON hasta alcanzar una OD600 = 0,5-1,0.  

3) Incubar en hielo durante 10 min. 

4) Centrifugar a 4000 rpm durante 7 min a 4 °C en tubos de centrifugación estériles. 

5) Descartar el sobrenadante y resuspender gentilmente el pellet en 1 ml de CaCl2 20 mM frío.  

6) Centrifugar a 2500 rpm durante 5 min a 5 °C y luego descartar el sobrenadante. 

 
 

 
 

 
 

 
 

 
 

 
 

 
 

 

 
 

 

 
 

 

Figura 14. Esquema de la transformación por choque térmico de células químicamente 

competentes. 
 

 

 
 

 

Figura 15. Esquema de la transformación por choque térmico de células químicamente 

competentes. 

Figura 23. Esquema de la transformación por choque térmico de células químicamente 

competentes. 
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7) Añadir 1 ml de CaCl2 20 mM frío y resuspender suavemente el sedimento celular.  

8) Distribuir las células competentes en alícuotas de 100 µl en microtubos 1,5 ml tipo Eppendorf y 

conservar a -80 °C. 

Anexo 4.  Transformación genética de A. tumefaciens mediante choque térmico 

1) Tomar 100 µl de bacterias competentes e incubar en hielo hasta que se descongelen. 

2) Añadir 5-10 µl de ADN plasmídico e incubar durante 30 min en hielo. 

3) Incubar durante 5 min a 37 °C (choque térmico). 

4) Añadir 1 ml de medio LB líquido sin antibiótico e incubar a 37ºC en agitación suave durante 2 h. 

5) Centrifugar a 4000 x g durante 5 min. 

6) Resuspender el sedimento celular en 100 µl de medio LB. 

7) Esparcir con espátula de Drigalski la suspensión bacteriana sobre una placa con medio LB con 

antibiótico e incubar a 28 °C durante dos noches.   

Anexo 5.  Detección y evaluación de GUS 

Reacción histoquímica 

El Buffer para la reacción GUS consistió en una disolución con las siguientes concentraciones finales: Buffer de 

reacción GUS (0,8 mM X-Gluc en DMSO, 100 mM buffer fosfato pH 7, 10 mM EDTA, 2 mM ferrocianuro de 

potasio, 2 mM ferricianuro de potasio, 1 μl/ml Tritón X-100).  

Para realizar el análisis histoquímico se siguió el siguiente protocolo: 

1) Retirar los explantos del medio de co-cultivo y realizar dos lavados con el buffer de 

reacción sin el reactivo X-Gluc. 

2) Transferir los explantos a pequeños frascos de vidrio e incubar en el buffer de reacción 

GUS. Sellar con film para evitar la evaporación e incubar en estufa durante ON a 37 °C en oscuridad. 

3) Lavar con etanol 70 %. En el caso de las hojas, realizar los lavados necesarios para producir 

la decoloración de la clorofila presente en los tejidos y poder observar las zonas transformadas con 

mayor claridad. 
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4) Evaluar visiblemente la presencia de precipitado azul sobre el tejido como indicador de la 

actividad GUS.  

 

Procesamiento y extracción de datos 

En la figura 24 se muestra parte del análisis digital de imágenes mediante el software ImageJ, el cual permitió 

obtener los valores de intensidad de pixeles a partir de las imágenes de los cotiledones. A la derecha de la Figura, 

señalado con el círculo rojo, se encuentra el histograma que muestra la distribución de frecuencias de los valores de 

intensidad de los píxeles. 

Hacia la derecha del histograma se ubican los píxeles con mayores valores de intensidad. Se observa que al 

seleccionar estos píxeles y comparar con la imagen original RGB, corresponden a la zona del cotiledón donde no 

hay tinción azul o esta es de menor intensidad. Por el contrario, al seleccionar los valores que se encuentran hacia 

la izquierda del histograma, es decir aquellos de menor valor de intensidad, la zona del cotiledón seleccionada 

presenta la mayor intensidad de tinción azul, comparando con la imagen RGB original. 

 

Figura 24. Procesamiento de las imágenes de cotiledones mediante el software ImageJ A) Conversión 

de la imagen original (RGB) a 8 bit. B) Obtención de los valores de intensidad. Los círculos rojos señalan 

el histograma con distintos valores de intensidad. 

A) 

 

A) 

 

A) 
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Protocolo de ImageJ para el análisis de cotiledones 

 Medición de cotiledones de tratamientos control: 

 

1)  Abrir la imagen del control en ImageJ  mediante el comando "File → Open…" 

2)  Convertir la imagen RGB a 8 bits mediante el comando "Image → Type → 8-bit", para trabajar 

con una escala de grises. 

3) Realizar un análisis exploratorio de la imagen mediante el comando "Image → Adjust → 

Threshold". Probar el umbral que arroja automáticamente el software y ajustar manualmente en caso de 

ser necesario. 

4) Delimitar la región de interés (ROI) mediante la herramienta de Selección libre. 

5) Comparar la imagen con la imagen original (RGB) y modificar el umbral mediante el comando 

"Image → Adjust → Threshold” hasta delimitar las zonas azules/celestes, que quedarán destacadas en 

color rojo. Esta región quedará delimitada por los valores de umbral mínimo y máximo.  

 

Medición de la zona de coloración azul en controles: 

 

6) Realizar la medición de la zona azul de cotiledón control a través de “Histogram”. Previo a la 

medición, utilizar el comando “Analyze  → Set Measurements → Limit to threshold” para realizar el 

análisis únicamente en la zona definida por el umbral en la zona delimitada. 

7) Utilizar el comando "Analyze → Histogram". Registrar los valores obtenidos, incluyendo los 

valores de intensidad y el número de píxeles utilizando el comando “Edit → Select All → Edit → Copy”. 

 

Medición de la zona total del cotiledón: 

 

8) Establecer un máximo de umbral de 255 antes de obtener el histograma para obtener todos los datos 

de intensidad a partir del mínimo. Luego utilizar el comando “Analyze → Histogram” y registrar valores 

como en el punto 7.  

Repetir los pasos 1-7 para todas las imágenes de los tratamientos control. 

 

B- Medición de cotiledones de tratamientos “GUS” 
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1) Abrir la imagen en ImageJ mediante el comando "File → Open…" Prestar atención a las áreas con 

coloración azul, indicativas de una posible transformación, y evitar la medición medir áreas que no deben 

ser consideradas. 

2) Convertir la imagen RGB a 8 bits mediante el comando "Image → Type → 8-bit". 

3) Realizar un análisis exploratorio de la imagen mediante el comando "Image → Adjust → 

Threshold". Probar el umbral que arroja automáticamente el software y ajustar manualmente en caso de ser 

necesario, disminuyendo el valor umbral hasta que quede cubierta el área completa. En este punto queda 

definido el valor de umbral mínimo. 

 

Medición del área total del cotiledón  

 

4) A partir de la imagen donde quedó establecido el umbral, seleccionar la ROI mediante la 

herramienta de Selección libre. Delimitar la zona a medir evitando que queden dentro, zonas del fondo que 

estuvieran coloreadas de rojo. 

 

5) Utilizar "Analyze → Set Measurements → Limit to threshold". Luego medir mediante el comando 

“Analyze → Histogram”. De esta forma se obtendrá el número total de pixeles que comprende el cotiledón 

(para ese umbral establecido) y quedarán a fuera zonas del fondo que pudiera verse también destacadas en 

color rojo.  

 

6) A través de la ventana de Histogram, registrar los valores obtenidos, incluyendo los valores de 

intensidad y el número de píxeles utilizando el comando Edit → Select All → Edit → Copy. Además, 

registrar el valor de Count, que corresponde al número total de pixeles.  

 

Análisis de la zona azul del cotiledón 

 

7) Comparar la imagen con la imagen original (RGB) y ajustar el umbral mediante el comando "Image 

→ Adjust → Threshold” hasta delimitar las zonas azules/celestes, que quedarán destacadas en color rojo. 

Esta región quedará delimitada por los valores de umbral mínimo y máximo. El objetivo es delimitar la 

zona en donde teóricamente se produjo la transformación. 

8) Abrir la ventana de Histogram y registrar los valores obtenidos. 

 

Medición del número de píxeles y área de la zona transformada 
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9) Ajustar el valor umbral indicando un valor mínimo (determinado en el paso 3), y como valor 

máximo indicar el valor umbral mínimo registrado para el control correspondiente. Los pixeles con valores 

de intensidad comprendidos entre este rango de umbral serán considerados como pixeles positivos (+) para 

la transformación.  

10) Realizar la medición mediante “Analyze → Histogram”. A través de la ventana de “Histogram”, 

registrar el valor de Count y los valores de intensidad de pixeles. 

Armado de tabla Excel 

 

Para registrar los valores obtenidos en el análisis, armar una tabla con las siguientes columnas: 

Tratamiento: indicar el número de tratamiento 

Tipo: si es control o GUS 

Cotiledón: número de cotiledón, que tomará como valores 1,2 o 3 

Foto: número de foto analizada 

Superficie: que cara del cotiledón fue analizada, es decir que podrá ser adaxial o abaxial 

Zona: representa qué zona del cotiledón fue analizada. Esta podrá ser:  

- Total, cuando los datos de intensidad de pixeles correspondan al total de la superficie el cotiledón. 

- Azul, zona que tiene coloración azul, ya sea en el control o en un tratamiento de transformación 

- Azul+, únicamente en tratamientos de transformación que dieran positivo para GUS (ver Item B: 

Medición de Tratamientos GUS)  

Min. Umbral: el número min de umbral considerado para obtener los datos del histograma. 

Max. Umbral: el número máximo de umbral considerado para obtener los datos del histograma. 

Intensidad: con valores de 0 a 255 

FA (frecuencia absoluta): número de pixeles para cada valor de intensidad. 
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